Interaction Client .NET Edition
Agent User Guide

Interaction Center Version 2.4

August 3, 2006
Copyright and Trademark Information


Other brand and/or product names referenced in this document are the trademarks or registered trademarks of their respective companies.

NOTICE
This product contains Information and/or data of Telcordia Technologies, Inc. (Telcordia) licensed to be included herein. Recipient acknowledges and agrees that (1) TELCORDIA AND ITS AFFILIATES MAKE NO REPRESENTATIONS, EXTEND NO WARRANTIES OF ANY KIND, EXPRESSED OR IMPLIED, AND ASSUME NO RESPONSIBILITY OR LIABILITY WHATSOEVER WITH RESPECT TO THE USE, SUFFICIENCY OR ACCURACY OF THE PRODUCT, (2) RECIPIENT SHALL MAKE NO CLAIM AGAINST TELCORDIA OR ANY OF ITS AFFILIATES WITH RESPECT TO THE PRODUCT, AND WAIVES ALL CLAIMS AGAINST TELCORDIA OR ANY OF ITS AFFILIATES WITH RESPECT TO THE PRODUCT, (3) IN NO EVENT SHALL TELCORDIA OR ANY OF ITS AFFILIATES BE LIABLE FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES RELATING TO THE PRODUCT, AND, (4) THIS AGREEMENT SHALL BE ENFORCEABLE BY TELCORDIA.

DISCLAIMER
Interactive Intelligence (Interactive) has no responsibility under warranty, indemnification or otherwise, for modification or customization of any Interactive software by Interactive, Customer or any third party even if such customization and/or modification is done using Interactive tools, training or methods documented by Interactive.

Interaction Center Platform Statement
This document describes Interaction Center (IC) features that may not be available in your IC product. Several products are based on the IC platform, and some features are disabled in some products. These products are based on the IC platform: Customer Interaction Center (CIC), Enterprise Interaction Center (EIC), and Communiqué.

While all of these products share a common feature set, this document is intended for use with all IC products, and some of the described features may not be available in your product.

How do I know if I have a documented feature?
Here are some indications that the documented feature is not available in your version:

• The menu, menu item, or button that accesses the feature appears grayed-out.
• One or more options or fields in a dialog box appear grayed-out.
• The feature is not selectable from a list of options.

If you have questions about feature availability, contact your vendor regarding the feature set available in your version of this product.
**Table of Contents**

**Introduction to Interaction Client .NET Edition** ............................................... 8  
**Terminology** ..................................................................... 9  
**Updating Your Workstation** ........................................... 12  
  Download an automatic update ......................................... 12  
  Manual updates .................................................................. 12  
**Understanding Call Objects** ............................................ 13  
**Using the Call Control Toolbar** ......................................... 14  
  Customize the Call Control toolbar .................................. 15  
  Custom Buttons ................................................................ 16  
**Using the Directory toolbar** .............................................. 17  
  Customize the Directory Toolbar ..................................... 18  
**Starting and Exiting Interaction Client .NET Edition** ............... 20  
  Startup Configuration Editor .......................................... 20  
  Login to Interaction Client .NET Edition .......................... 23  
  Use profiles to login ....................................................... 23  
  Save a login profile ....................................................... 23  
**Recording Your Important Prompts** .................................... 25  
**Working with Status Options and Features** ....................... 28  
**Managing Phone Calls** ................................................... 29  
  Make a call ..................................................................... 30  
  Answer a call .................................................................. 30  
  Place a call on hold .......................................................... 30  
  Disconnect a call ............................................................. 30  
  Forward your calls to a remote number ............................. 30  
  Selectively redirect your calls .......................................... 31  
  Set up follow-me routing numbers ................................... 32  
  Start follow-me routing ................................................... 33
Introduction to Interaction Client .NET Edition

Transferring Calls .............................................. 34
  Transfer a call to another person .............................. 34
  Transfer a call without consulting the recipient ............. 34
  Transfer a call after consulting the recipient ............... 35
  Transfer a call to someone else's voicemail ............... 35

Parking Calls ....................................................... 36
  Park on someone else's extension ........................... 36

Understanding orbit queues ..................................... 37
  Display the orbit queue ....................................... 37
  Park a call in orbit .......................................... 38
  Pick up a call from an orbit .................................. 38

Conference Calling ........................................... 39
  Create a conference session .................................. 39
  Add someone to a conference session ....................... 39
  Participate in a conference call using Join ............... 39
  Disconnect someone from a conference call ............... 39

Working with Voicemail ...................................... 40
  Pick up a call from voicemail ................................ 40
  Listen to someone leave a voicemail message ............. 40
  Pick up a call recording a voicemail message ............ 41
  Transfer a call to your voicemail ............................ 41
  Transfer a call to another person's voicemail ........... 41

Understanding Unified Messaging ............................ 42
  Overview of Interaction Voicemail Player .................. 43
  Using the Interaction Voicemail Player .................... 43

Understanding the Interaction Voicemail Player and .wav files ................................ 44
  Configure the Interaction Voicemail Player ............... 44
  Using Interaction Voicemail Player Controls ............. 45
  Open a voicemail message from your Inbox ............... 46
  Use the Voicemail List ....................................... 47
  Display the Voicemail List Playback interface ............. 49

Using Voicemail and Fax Paging ......................... 50
  Set voicemail alert options .................................. 50
  Voicemail and fax paging options ............................ 50

Working with Email ........................................... 52
  Pick up or reopen an email ................................... 53
  Reply to an email .............................................. 54
  Transfer an email .............................................. 55
  Automatic email spell-checking .............................. 55
Working with Account Codes ............................... 56
  Assign an account code to an incoming interaction ......... 57
  Assign an account code to an Interaction Object .......... 57
  Assign an account code to an outgoing interaction using the Account Code field ..................... 58
  Assign an account code to an outgoing interaction using the Properties window ....................... 58
  Assign an account code to an outgoing interaction from the handset ..................................... 59
  Numerically sort account codes ............................ 59

Understanding wrap-up codes .............................. 60

Understanding Generic Object Routing .................. 62

Monitoring Other Users ...................................... 63
  Set up monitored appearances .............................. 64
  Customize monitored appearance alerts .................... 64
  Rename a monitored appearance alert ...................... 65
  Remove a monitored appearance alert from your client window ............................................. 66
  Permanently delete a monitored appearance alert ........ 66

Implementing Personal Rules .............................. 67
  Create a personal rule ...................................... 67
  Understanding attribute names and values ............... 68
  Specify an attribute name or value ....................... 69
  Play audio files to caller .................................... 69
  Copy a personal rule ........................................ 69
  Edit a personal rule ........................................ 69
  Rearrange personal rule processing order ............... 70
  Turn a personal rule on or off ............................. 70
  Delete a personal rule ...................................... 70

Setting Up Desktop Alerts ................................. 71

Setting Page Options ....................................... 72
  Add a page to the Interaction Client .NET Edition window ..................................................... 72
  Manually set page options .................................... 73

Changing the Page Layout .................................. 74
  Move a page to a new location .............................. 75
  Turn off the ability to dock or rearrange pages ........ 76
  Return to a default page layout ............................. 76
Introduction to Interaction Client .NET Edition

Welcome to the Interaction Client .NET Edition User Guide! This guide was designed to meet the needs of business users and others who work with Interaction Client .NET Edition.

Interaction Client .NET Edition is a powerful interaction and communications manager for desktop or laptop PCs, and offers more functionality than your office telephone. Use it to manage all your electronic communication, including phone calls, conference interactions, and voicemail.

In this guide, you’ll find at-a-glance quick reference tasks for all interactions, as well as conceptual information for these Interaction Client .NET Edition features.

Each feature is described in detail, and provides commands and shortcuts available to you as you navigate through the system.
Terminology

The following definitions describe terminology you may encounter throughout this guide.

**ACD**
Automatic Call Distributor. An ACD system routes calls based on agent availability and skills, trunk line used, caller input, volume of calls, time of day, agent groups, or other variables.

**Agent**
An Interaction Client .NET Edition user set up as a member of an ACD workgroup.

**Blind transfer**
An Interaction Client .NET Edition feature you can use to transfer a call without consulting the recipient.

**Call object**
Call objects represent interactions, and appear in the My Interactions queue on the My Interactions tab. You can perform actions on the call object, such as transferring it or sending it to voicemail.

**Camp**
This Interaction Client feature allows users to ask to be notified when another Interaction Client user's status becomes available. For example, if you see that an Interaction Client user's status is set to On the Phone, you can choose to camp on that user's extension. When that user's status becomes Available, a dialog box appears asking you if you would like to call that user.

**Chat interaction**
A chat interaction is the text-based interaction between a person browsing your web site and an Interaction Client .NET Edition user. Chat interactions can be queued, transferred, and placed on hold just like telephone calls.

Intercom chat, a basic variation of a chat interaction, lets agents chat among themselves online inside a company.
Terminology

Conference session
A conference session exists when you connect three or more people into one interaction. Any Interaction Client .NET Edition user can add participants to a conference session. You may have up to thirty-two participants (including yourself) in a conference call.

Consult transfer
An Interaction Client .NET Edition feature you can use to transfer a call after consulting the recipient.

Directory
A list of defined and predetermined contact information within Interaction Client .NET Edition. Directories can include employee contact listings, general listings (public and private contacts in address books) and workgroup directories. The directories available for you to view depend on your rights as set up in Interaction Administrator.

Email
Usually refers to electronic text mail more than to electronic voicemail, both of which are messages sent across a network of some kind. Most email systems, such as Microsoft Exchange, support voice, image, and text data in messages. In IC, faxes and voicemail messages are sent as file attachments to email messages.

Interaction
A communication between two parties, including telephone calls, chat interactions, email, voicemail, fax, conference calls, and so on. Each interaction is represented by a queue item on a queue.

Orbit Queue
An Orbit Queue is a list of all calls parked to specific locations. This feature is especially helpful for Public Announcement system operators who can park a call in Orbit, then page the recipient and relay that he or she has a call on a specific Orbit (i.e. “John Doe, you have a call on Orbit 12”, thus allowing John Doe to move to any station and pick up the call). A user can also park a currently active call in a specific orbit, thereby removing the call from his or her station and enables the user to pick it up from another station.
**Park**
A feature used when transferring calls. To transfer a call to an Interaction Client .NET Edition user that is unavailable to take the call, park the call on the recipient's extension. When the recipient is free, the call will transfer to his or her queue.

**Queue**
In Interaction Client .NET Edition, a queue is a container for interactions that can be processed. In Interaction Client .NET Edition, you’ll encounter User queues, Station queues, Workgroup queues, System queues, and ACD queues.

**Speed dial**
Speed dialing lets you quickly dial frequently called numbers. Each speed dial entry on a speed dial page represents a number that you call frequently. To add Speed Dial pages, see Setting Page Options on Page 72.

**Status**
For a user queue, a status is either available or unavailable (or unavailable with a return time.) A status of unavailable can be displayed as On Vacation, At Lunch, In a Meeting, or several other messages displayed in the Interaction Client .NET Edition. Return times are also set from the Interaction Client .NET Edition.

**User Queue**
A queue where interactions (such as calls and chat interactions) intended for an individual user are routed.

**Voicemail**
Electronic voicemail. In Interaction Client .NET Edition, voicemail is sent as a .WAV file attached to an email.

**Workgroup**
A defined group of users related by function, department, project, or other organization. Workgroups can have extensions and queues, which enable all members of a workgroup to receive calls passed to the workgroup.
Updating Your Workstation

Interaction Client .NET Edition checks for software updates after a restart, and then again every 24 hours after the restart.

Download an automatic update
1. When prompted by a dialog box indicating an update is available, click Yes to download the update. Overall Progress and Downloading indicators appear.
2. When the download is complete, click OK.
3. Click OK to restart Interaction Client .NET Edition and run the updated client, or click Cancel to prevent your computer from restarting. The updates will be applied after the next restart.

Manual updates
1. Open the File menu and click Check for updates.
2. In the Options dialog box, select the Interaction Client tab and click Check Now. The Interaction Client .NET Edition dialog box appears.
3. Click Yes to download the updates, or click OK if Interaction Client .NET Edition is already up to date.
4. If you downloaded an update, click OK to restart Interaction Client .NET Edition and run the updated client, or click Cancel to prevent your computer from restarting. The updates will be applied after the next restart.
Understanding Call Objects

In Interaction Client .NET Edition, an interaction is a communication between two parties. This can include telephone calls, conference sessions, chat interactions, emails, voicemails, and faxes. Each interaction is represented in Interaction Client .NET Edition by a call object on a queue. An interaction is identified in a queue by an icon.

Call objects appear in your My Interactions queue (Figure 1) and include all interactions.

**Note:** Tabs on Interaction Client .NET Edition pages contain a special focus indicator (↕). An area that contains this focus indicator will be the area to receive keyboard input.

The following sections describe Interaction Client .NET Edition features as well as typical interactions you may encounter.

![Image of My Interactions queue](Figure 1. My Interactions queue.)
Using the Call Control Toolbar

Use the buttons on the Interaction Client .NET Edition Call Control toolbar to help you manage your calls. Many of these functions are also available by right-clicking an interaction. You can customize a Call Control toolbar for each page in your client window.

Some buttons may not be available in all situations. If a button appears shaded, or grayed-out, you may not be able to use it on that interaction, or the button may not be available to you.

Toolbar buttons have shortcut keys assigned to them. Pressing shortcut keys performs the same task as pressing the button or field. The underlined character of the text appearing on the button or field designates the shortcut key. On the Call Control button bar, simultaneously pressing the **Ctrl** key and the underlined character will activate the shortcut.

Remember to highlight the interaction you want to take action on before you click a button on the toolbar. The Call Control toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Pickup</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>✗</td>
<td>Disconnect</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>⏸</td>
<td>Hold</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>🔄</td>
<td>Transfer</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>📭</td>
<td>Voicemail</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>📣</td>
<td>Join</td>
<td>Ctrl+J</td>
</tr>
<tr>
<td>🎧</td>
<td>Listen</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>🎯</td>
<td>Coach</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>🎧</td>
<td>Record</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>🗝</td>
<td>Mute</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>⏹</td>
<td>Pause</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>🗝</td>
<td>Private</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>🕵️</td>
<td>Assistance</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>📚</td>
<td>Properties</td>
<td>Ctrl+Shift+P</td>
</tr>
</tbody>
</table>
Customize the Call Control toolbar

1. Click the page whose Call Control toolbar you want to configure, then right-click anywhere in the Call Control toolbar area and choose Customize.... The Customize Toolbar window opens.

2. To add a button to the toolbar, in the Available toolbar buttons: list, highlight the desired button and click Add ->. Your selection appears at the bottom of the Current toolbar buttons: list.

   Note: Insert one or more Separator lines to divide the toolbar buttons into groups.

3. To remove a button from the toolbar, in the Current toolbar buttons: list, highlight the button you want to delete and click <- Remove. The button should reappear in the Available toolbar Buttons: list.

4. To rearrange the order of your toolbar buttons, in the Current toolbar buttons: list, highlight the button you want to move and then click Move Up or Move down, depending on the location you choose to place the button, until the button is in the desired place.

5. To change the way the toolbar buttons appear, click the arrow at the end of the Text Options drop-down list and if you want a description of the button shown underneath the icon choose to Show Text Labels. If you want to display only the icon choose No Text Labels.

6. To configure the Call Control toolbar for another page, click that page and repeat steps 1-5.

7. To return a toolbar to the default configuration, click the Reset button.
Custom Buttons

Your Interaction Center administrator can create custom buttons for the Call Control toolbar. These buttons are defined in Interaction Administrator.

A custom button can invoke a handler or launch a local application. The button can be set to be available always, when any interaction is selected or when an active (not disconnected) interaction is selected.

You can remove a custom button from the Call Control toolbar just like any of the other interaction buttons. All custom buttons are shown by default and appended to the right side of the Call Control toolbar. The actions performed by custom buttons are also listed on the context menu.

Any new custom buttons added by the Interaction Center administrator appear on your Call Control toolbar after you load the appropriate update. Custom buttons removed by the IC administrator are also removed from your Call Control toolbar and the Customize Toolbar dialog box.
Using the Directory toolbar

Use the Interaction Client .NET Directory toolbar to help you manage the flow of incoming interactions. The Directory toolbar is located at the bottom of the Interaction Client .NET Edition window (Figure 2). You can customize a Directory toolbar for each page in your client window.

Some buttons may not be available in all situations. If a button appears shaded, or grayed-out, you may not be able to use it on that interaction, or the button may not be available.

**Note:** The Directory toolbar does not contain all available buttons. For a comprehensive list of buttons you can include on your toolbar, see the Interaction Client .NET Edition Online Help.

Remember to highlight the interaction you want to take action on before you click a button on the Directory toolbar.

![Figure 2. Directory Toolbar.](image)
## Using the Directory toolbar

The Interaction Client .NET Directory toolbar contains the following default buttons:

<table>
<thead>
<tr>
<th>Toolbar button</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial</td>
<td>Enter</td>
</tr>
<tr>
<td>Transfer</td>
<td>Shift+Enter</td>
</tr>
<tr>
<td>Business (Email)</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Camp</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Properties</td>
<td>Ctrl+Shift+P</td>
</tr>
<tr>
<td>Business (Telephone)</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Chat</td>
<td>Ctrl+Shift+C</td>
</tr>
<tr>
<td>Mobile</td>
<td>Ctrl+I</td>
</tr>
</tbody>
</table>

## Customize the Directory Toolbar

The Directory toolbar can be a powerful tool to direct and manage interactions. You can customize the toolbar to better suit your needs.

**Note:** When you customize a toolbar, pay particular attention when you hover your mouse over a specific button. Some buttons may have the same label name, but with different icons. For example, the Customize Toolbar page shows three separate Mobile buttons, but one button represents **Transfer**, one represents **Consult**, and another represents **Dial**. Also, some buttons have the same icon but different labels.

![Figure 3. Customize Toolbar window.](image)
Customize the Directory Toolbar:

1. Click the directory page whose Directory toolbar you want to configure, then right-click anywhere in the Directory toolbar area and choose Customize.... The Customize Toolbar window opens.

2. To add a button to the toolbar, in the Available toolbar buttons: list, highlight the desired button and click Add ->. Your selection appears at the bottom of the Current toolbar buttons: list.

   Note: Insert one or more Separator lines to divide the toolbar buttons into groups.

3. To remove a button from the toolbar, in the Current toolbar buttons: list, highlight the button you want to delete and click <- Remove. The button should reappear in the Available toolbar Buttons: list.

4. To rearrange the order of your toolbar buttons, in the Current toolbar buttons: list, highlight the button you want to move and then click Move Up or Move down, depending on the location you choose to place the button, until the button is in the desired place.

5. To change the way the toolbar buttons appear, click the arrow at the end of the Text Options drop-down list and if you want a description of the button shown underneath the icon choose to Show Text Labels. If you want to display only the icon choose No Text Labels.

6. To configure the Directory toolbar for another page, click that page and repeat steps 1-5.

7. To return a toolbar to the default configuration, click the Reset button.
Starting and Exiting Interaction Client .NET Edition

Startup Configuration Editor

The Startup Configuration Editor is the dialog box that is displayed when you open Interaction Client .NET Edition. Use this dialog box to set your login information and other options when logging in. There are three available tabs: Connection, Options, and Other.

Connection Tab

Use this tab to enter authentication details and server connection information.

- **Use Windows Login Authentication:** Select this checkbox to login to Interaction Client .NET Edition using your Windows user ID and password. **Note:** The Interaction Administrator must first enable this option by linking Windows user names and Interaction Client .NET Edition user names.

- **User ID:** Enter the name of your user account as set up in Interaction Administrator. To verify your user account name, contact your IC administrator. **Note:** If Use Windows Login Authentication is selected, this field is disabled.

- **Password:** Enter your password as set up for you in Interaction Administrator. If you have forgotten your password, contact your IC administrator. **Note:** If Use Windows Login Authentication is selected, this field is disabled.

- **Save Password:** Select this checkbox if you do not want to enter your password each time you login to Interaction Client .NET Edition. **Note:** The password is saved to the i3client file (profile) securely and is only valid for this PC and this login. For example, if you attempt to use this profile on a different PC the password cannot be decrypted.

- **Host:** Enter the host name. This is the machine running the Interaction Center SessionManager and BridgeHost. For most installations, this is the same as the Interaction Center server.

- **Station Type:** This is the type of station you are using to run Interaction Client .NET Edition.
1. **<this computer>:** Select this option if you move around the office and login from different local workstations. This option ensures calls are routed to the station associated with this computer, not the last workstation you logged into. This is essentially the same as the Workstation type.

2. **Workstation:** Use a computer and telephone connected via telecom outlet (SIP or analog phone) to the IC server.

3. **Remote Workstation:** Work from a "known" single remote location using a single phone number for all calls to the agent's extension; "known" is being defined in Interaction Administrator.

4. **Remote Number:** Work from an ad-hoc remote location using a single phone number for all calls to the agent's extension.

5. **PC Audio:** Use the computer as the telephone (also called a *soft phone.* ) **Note:** These stations have to be configured in Interaction Administrator. Also, real-time clock (RTC) is required.

- **Workstation:** If you select Workstation, Remote Workstation, or PC Audio as your station type, enter the name of the workstation here. If you select Remote Number, then this field is disabled (grayed-out).

- **Remote Number:** For remote access only, enter the phone number IC should use to call the agent.

- **Persistent:** This is for remote access only. Place a checkmark in this box and the connection to the IC Server remains connected from the first time you perform an operation until you log off the system. Remove the checkmark in this box and the IC server terminates calls to your remote phone when either side disconnects for any reason. This setting can also be turned off in Interaction Administrator. **Note:** Usually this preferred setting prevents excessive long distance charges and keeps lines free.

---

**Interaction Client .NET Edition Call Center Agent User Guide ♦ 21**
Starting and Exiting Interaction Client .NET Edition

- **Default.i3client:** The first time you start Interaction Client .NET Edition, it automatically loads the Default.i3client default settings file, if it exists. The Interaction Client .NET Edition stores profiles here: %APPDATA%\Interactive Intelligence\InteractionClient\Profiles.

If this file does not exist, the Startup Configuration Editor opens, and you can enter the desired information in the appropriate fields. The next time you open Interaction Client .NET Edition, the Startup Configuration Editor will be bypassed.

Instead of using the default, you can click Start, Programs, and then Interactive Intelligence to open the Startup Configuration Editor to create a new profile. After you create the new profile, click **Save As** to save the file to your desktop or another convenient place. Use the format filename.i3client for the filename. When you double-click that file you bypass the initial login screen and connect to the client. If you want to change your startup settings, right-click on that file and select **Edit**.

**Options Tab**

Use this tab to select details including Language, Splash Screen and instances options as shown below:

- **Override Default LCID:** Select this checkbox to change the language used for Interaction Client. **Note:** This option is effective only when corresponding language modules have been installed on the server. Interaction Client will pull the appropriate language packs it needs, if available.

- **Show Splash Screen:** Select this checkbox to display the splash screen when starting Interaction Client .NET Edition. De-select the checkbox to turn off the splash screen display.

- **Activate existing instance:** Select this checkbox for a previous instance of Interaction Client .NET Edition will pop instead of starting a new instance, saving loading time. De-select this option to load a new instance every time you start the client. **Note:** By selecting this option, you can create a Windows shortcut to an i3client file and give it a shortcut-key sequence. You can then pop the client from any application. For example, you could create the shortcut-key sequence as Ctrl+Alt+I.
• **Confirm multiple instances:** Select this checkbox to display a "yes/no" dialog box that asks if you want to run another instance of the client when another instance is running. De-select this option if you do not want the "yes/no" dialog box displayed.

*Other Tab*

See your IC administrator for information and settings on this tab.

**Login to Interaction Client .NET Edition**

If you chose to use the default profile settings created in Default.i3client, double-click the **Interaction Client .NET Edition icon** on your desktop, or open the **Start** menu, choose **Programs**, then click **Interaction Client .NET Edition**. The client opens automatically.

**Use profiles to login**

Interaction Client .NET Edition automatically creates a default profile the first time you login. This creates defaults for future logins. You can create alternate profiles for different users who share the same workstation or remote users who use different workstations to login.

---

**Save a login profile**

1. Complete the fields on the Connection tab of the Startup Configuration Editor.
2. After completing the fields, click **Save As**.
3. In the Save As dialog box, type a profile name in the File name box. Use the format `filename.i3client` for the filename. You can save the profile to your desktop, and double-clicking on it automatically logs you in. This method bypasses the Startup Configuration Editor.
4. Click **Save**.

**Use a profile to login**

1. In the Startup Configuration Editor, on the Connection tab, click **Open**.
2. In the Open dialog box, select the appropriate profile and click **Open**.
3. In the Startup Configuration Editor, click **Connect**.
Log out of Interaction Client .NET Edition

You can log out of the Interaction Client .NET Edition and keep the application open by clicking **Logout** from the **File** menu. This enables you to access directories when you are offline. This is especially useful for remote users.

Exit Interaction Client .NET Edition

To exit Interaction Client .NET Edition, open the **File** menu and choose **Exit**. Clicking the **X** (which typically exits an application) in the upper-right corner of Interaction Client .NET edition only hides it.

**Note**: When you exit Interaction Client .NET Edition and log out, your non-ACD (Automatic Call Distribution) calls ring on your telephone if the station associated with the telephone is set up as your default workstation in Interaction Administrator. Otherwise, the system announces to callers that you are not available.

Automatically reconnect to Interaction Client .NET Edition

If Interaction Client .NET Edition loses the connection to the server, it automatically attempts to re-establish the connection every 20 to 90 seconds. The range in seconds allows random reconnection which prevents all clients reconnecting at the same time and eases the load on the IC server. Users may also choose to login manually.
Recording Your Important Prompts

Personal prompts are messages you record and are played to people who call you. The specific prompts played depend on your status. The default statuses are divided into two categories; DND (Do Not Disturb) and a form of Available. Your IC system administrator assigns these attributes to statuses in Interaction Administrator.

For example, if your status is DND (e.g., At Lunch, Out of Town, Gone Home, etc.), then calls are automatically directed to your voicemail (the call does not ring to your station). If you have recorded an "Out of Office Message", then your "Out of Office Message" immediately plays to the caller. If you have not recorded an "Out of Office Message," then the appropriate status message plays to the caller. The status message also plays if you have recorded the "Out of Office Message" but have not activated it. If a status message is not recorded, the generic message is, "<Your name> is not available. Please leave a message after the tone."

If your status is a form of Available (Available, No ACD, Available Forward, Available, etc.), then interactions alert your queue. If you recorded a "No Answer Message" and you do not answer an incoming call (the alert times-out), then your "No Answer Message" plays to the caller. If you have not recorded this personal prompt, then the above-mentioned generic personal message plays to the caller.

Figure 4. Personal Prompts page.
Recording Your Important Prompts

Understanding personal prompt options

The Personal Prompts page (Figure 4) includes the following options:

- **Activate Out of Office Message**: Select this checkbox to activate your Out of Office message. Be sure to record your Out of Office Message before you use this option for the first time.

- **Activate Agent Greeting**: Select this checkbox to activate your Agent Greeting message. Be sure to record your Agent Greeting Message before you use this option for the first time.

The following section describes the types of prompts you can record.

- **Record Out of Office**: Use this button to record a message played to callers when you have set your status to one of the unavailable statuses (i.e. any status other than Available or Available, Forward or Available, No ACD). You must also select the Activate Out of Office Message box.

- **Record No Answer Message**: Use this button to record a message played to callers if your status is in a form of Available and you do not pick up an incoming call. (You may not be at your phone, or you may be talking on another line, or you may choose to send the call to voicemail, etc.).

- **Record Follow Me Message**: Use this button to record a message to play to callers if your status is set to Available, Follow Me. When you set your status to Available, Follow Me, your Follow Me message plays to callers while Interaction Client .NET Edition consecutively calls you at a series of numbers you set up to find you and eventually connects you to the caller.

- **Record Name**: Use this button to record your name. This recording is played for all callers who dial your extension.

- **Record Agent Greeting**: Use this button to record a message to play to callers before you answer an ACD call. This greeting is intended for use by call center agents who are members of a workgroup and are receiving ACD calls. You must also select the Activate Agent Greeting box. This feature is best used with the Auto Answer Calls (user/agent attribute set in Interaction Administrator). When used with Auto Answer Calls enabled, your Agent Greeting plays to the caller as you are being alerted. The length of your Agent Greeting is limited to 10 seconds, and therefore, is considered an introduction or "smile". 
- **Record Available, Forward Message:** Use this button to record a message to play to callers when your status is set to Available, Forward.

  This message is played to callers while they wait for Interaction Client .NET Edition to forward the call to you at another location.

  This prompt enables users to control the message Interaction Client .NET Edition plays to callers when it forwards calls to a remote location. If you don't record this prompt, callers do not hear an announcement about your forwarding status and are unaware that they are being forwarded.

---

### Set personal prompts options

1. Open the **Options** menu and click **Configuration...**

2. Expand the **Calls** node and click **Personal Prompts**.

3. On the right side of the window, click the button of the prompt you want to record.

4. Follow the instructions that appear on your screen.

5. To review a recorded prompt, click the **Preview** button.

6. To return a prompt to a generic recording, click the **Reset** button.

7. Click **OK** to close the **Configuration** window.
Working with Status Options and Features

Set your status

1. In the Interaction Client .NET Edition window, click the arrow at the end of the My Status box.
   Or in the notification area of your taskbar (located at the bottom right side of your main window), right-click your Interaction Client status icon.
   Or in the Company Directory, right-click your name and choose Change User’s Status.

2. Choose a status from the menu and, if applicable, click the OK button.

View another person’s status

Right-click a person’s name in the Company directory. Interaction Client .NET Edition lists the person’s availability on the menu that appears.

Set another user’s status

If your IC administrator has granted you the right, you may also set another user’s status in the Company Directory or other directory page.

1. Right-click the user’s name in the Company Directory or other directory page.

2. Select Change User’s Status from the menu that appears. The Set Status window appears.

3. Select a status from the drop-down list and enter other status information that is applicable.

4. Click OK.
Managing Phone Calls

Interaction Client .NET Edition helps you manage calls in a variety of ways, including making calls, picking up, disconnecting, and forwarding calls, and placing calls on hold.

The following tasks assume you are managing calls from your My Interactions queue (Figure 5), but you can manage calls from any queue you are monitoring. Remember to highlight the interaction you want to take action upon when you begin a task.

**Note:** Tabs on the Interactions page contain a special focus indicator ( ). An area that contains this focus indicator will be the area to receive keyboard input.

![Figure 5. My Interactions queue.](image-url)
Managing Phone Calls

Make a call
1. Open Interaction Client .NET Edition and in the **Number**: field, type the phone number you want to call.
2. Click the **Make Call** button or press **Enter**.

Answer a call
If you are not connected to another call, pick up your telephone handset. If you are connected to another call, click the **Pickup** button. The system places on hold any other calls to which you are connected.

Place a call on hold
1. Click the call you want to place on hold, then click the **Hold** button or right-click the call and choose **Hold** from the menu that appears.
2. To reconnect to the call, click the call you want to pick up and click the **Hold** button again.
3. To suppress hold music for the caller, click **Mute** before or after clicking **Hold**.

Disconnect a call
1. To disconnect a call with your handset, just hang up the telephone.
2. To disconnect a call from Interaction Client .NET Edition:
   - Highlight the call you want to disconnect.
   - Click the **Disconnect** button or right-click the call and choose Disconnect from the menu that appears.

Forward your calls to a remote number
If you will be away from your desk but accessible at another telephone number, you can forward your calls to an internal extension, a local number, a long distance number, or even a cellular telephone. You must set your status to **Available, Forward**. Interaction Client .NET Edition redirects all calls originally targeted at your local extension to the remote number.

![Figure 6. Set Status Details box.](image-url)
Your IC administrator can create multiple Forwarding statuses if your site requires it. For example, you could have Available Forward, Home and Available Forward, Mobile. To forward your calls to a remote number:

1. Click the My Status drop-down list.
2. Select Available, Forward from the list. The Set Status Details box opens (Figure 6).
3. In the Forward Number: field; enter the remote telephone number for forwarded calls.
4. Click OK. Your status is set to Available, Forward and all calls are forwarded to the remote number. The forwarding number appears as a link next to the My Status drop-down list:

   ![My Status dropdown](image)

5. If you have previously set your status to Available, Forward but want to change the forwarding telephone number, click the link containing your forwarding number to the right of the My Status list.
6. Make your changes in the Set Status Details box and click OK.

**Selectively redirect your calls**

If you need to redirect some or all of your calls to another person, use the Call Coverage configuration page (Figure 7) to specify which calls to redirect. For each of the call coverage options, you can choose to forward all calls that come to you, only internal calls, only external calls (from outside the office), or only calls from an unknown source (e.g., no caller ID or no match in the white pages database).

![Call Coverage configuration page](image)
Managing Phone Calls

To selectively redirect your calls:

1. Open the **Options** menu and choose **Configuration**.

2. Click **Call Coverage** (Figure 7).

3. Click the **Coverage Option** that specifies when you want calls to be forwarded. Click the **Forward** check box to forward all calls of the designated type.

4. Click the type of calls you want to forward (All Calls, Internal, External, or Unknown).

5. In the **Send my calls to:** field, enter the phone number where calls will be forwarded. This can be an internal extension or a remote phone number.

6. If you specify an internal extension and that extension does not answer a forwarded call, the caller can leave a voicemail. If you want the voicemail to go to the Inbox of a different extension, click or enter that extension in the combo box labeled **If the caller leaves voicemail, send it to:**.

7. Click **OK** to save the changes and activate the call coverage options.

Set up follow-me routing numbers

1. Open the **Options** menu and choose **Configuration**.

2. Under the **Calls** container, click **Follow Me**.

3. In the **Phone Number** field, enter the number you want the system to call if you aren’t available.

4. In the **Timeout** field, enter the number of seconds you want the system to ring this number. If you don’t enter a number in this field, the system defaults to 15 seconds.

5. If you want call recipients to enter your Interaction Client .NET Edition password to accept the call, check the **Pin** box.

6. To add another number, repeat steps 2-5.

7. To move a number up in the list, highlight the number and press the **Move up** button. To move a number down in the list, highlight it and press the **Move down** button.

8. To delete a number, press **Delete**.

9. To prompt callers for their name, click the **Screen Calls** checkbox.

10. Click **OK** to save your settings.
Start follow-me routing
1. Set up follow-me routing numbers.
2. Change your status to *Available, Follow me.*
Transferring Calls

Interaction Client .NET Edition lets you transfer and park telephone interactions in a variety of ways. You can mute telephone interactions when you transfer them, and you can transfer interactions with or without consulting the recipient. Use the Transfer window (Figure 8).

![Figure 8. Transfer window.](image)

Transfer a call to another person

In Interaction Client .NET Edition, you can transfer a call to another user. Inform the caller of the transfer, then in your My Interactions list click the call you want to transfer and either:

- Drag it to a name in the Company Directory (or other available directory). The Transfer window appears. Click Yes to transfer the call, or click No to cancel the action.

- Or click the Transfer button (or right-click the call and choose Transfer from the menu appears). The Transfer dialog box appears. In the Transfer To: box, enter the transfer recipient’s number and choose how you want to transfer the call.

  Note: You can also transfer a call by right-clicking a name in any directory, or by right-dragging a call other than the one to which you are connected, and choosing Transfer Connected Call from the menu that appears.

Transfer a call without consulting the recipient

1. Inform the caller of the transfer, then in My Interactions click the call and either:

2. Drag it to a name in the Company Directory (or other available directory). The Transfer window appears. Click Yes to transfer, or click No to cancel the action.

   Or click the Transfer button (or right-click the call and choose Transfer from the menu appears). The Transfer dialog box appears. In the Transfer To: box, enter the transfer recipient’s number and choose how you want to transfer the call.

3. Click Transfer Now to immediately send the call to the recipient.
Transfer a call after consulting the recipient
1. Inform the caller of the transfer, then in **My Interactions** click the call you want to transfer and either:

2. Drag it to a name in the Company Directory (or other available directory). The **Transfer** window appears. Click **Yes** to transfer the call, or click **No** to cancel the action.

   Or click the **Transfer** button (or right-click the call and choose **Transfer** from the menu appears). The Transfer dialog box appears. In the **Transfer To:** box, enter the transfer recipient’s number and choose how you want to transfer the call.

3. Click the **Make Consult Call** to allow you to speak to the recipient before transferring it.

Transfer a call to someone else’s voicemail
1. Inform the caller of the transfer, then in **My Interactions** click the call you want to transfer and either:

2. Drag it to a name in the Company Directory (or other available directory). The **Transfer** window appears. Click **Yes** to transfer the call, or click **No** to cancel the action.

   Or click the **Transfer** button (or right-click the call and choose **Transfer** from the menu appears). The Transfer dialog box appears. In the **Transfer To:** box, enter the transfer recipient’s number and choose how you want to transfer the call.

3. Click **Send to Voice Mail** to transfer the caller to the recipient’s voice mail.
Parking Calls

Park on someone else’s extension

1. Inform the caller you’re parking him or her onto another person’s extension.

2. Click the **Transfer** button (or right-click the call and choose **Transfer** from the menu that appears).

3. In the **Transfer To:** box; enter the transfer recipient’s number.

4. Click the **Park** button. The call disappears from **My Interactions** and is placed on hold in the recipient’s **My Interactions** so the recipient can select it later.
Understanding orbit queues

An Orbit Queue is a list of all calls parked to specific locations. This feature is especially helpful for Public Announcement system operators who can park a call in Orbit, then page the recipient and relay that he or she has a call on a specific Orbit (i.e. “John Doe, you have a call on Orbit 12”, thus allowing John Doe to move to any station and pick up the call).

This feature is also helpful for operators and receptionists who can monitor parked calls and pull them back from a parked queue if no one answers the call. An Orbit page for parked calls gives the operator a central view to see all parked calls.

When you park a currently active call in a specific orbit it removes the call from your station. This enables you to pick up the call from another station and resume the call without having to transfer it to a specific extension.

Depending on the hold behavior your IC administrator configures, callers "in orbit" hear a combination of music and messages. To a caller, there is no difference between being on hold or in orbit.

Display the orbit queue

You can view a list of all parked calls by displaying the orbit queue in Interaction Client .NET Edition. The Orbit Queue page (Figure 9) displays the details of the parked calls, including the orbit number and how long the call has been parked on an orbit.

To display the Orbit Queue:

1. From the Options menu, choose Configuration..., and click Pages. Or right-click on tabs in the area where you want to add a page and choose Pages... from the menu that appears.

2. In the Client Pages dialog box, from the Queue list, select General Pages.

3. In the Pages list, select Orbit Queue.

4. Click Apply to save your selections.

5. Click OK to close the Configuration dialog box.
Understanding orbit queues

Park a call in orbit

1. In the My Interactions page or any other queue page, if the call is not already selected, click the call to select it.

2. Right-click the call and choose Park on Orbit from the menu that appears, or click the Park button. The Orbit Park window appears:

3. In the Orbit Park window, assign a number to this orbit by typing a number in Park call on Orbit. You can use any single digit to 9 digit number, and 10 digit numbers up to 4294967294. Avoid orbit numbers starting with 0 (zero). The number defaults to the last orbit number used.

4. Click Park. (If the orbit number is currently in use, you are prompted to choose another orbit number.) The call is removed from My Interactions and the call's state changes to Parked. You can view the call in the Orbit Queue page.

5. To suppress on-hold music for the other party, click the Mute button before or after placing the call in orbit.

Note: Your IC administrator can configure a maximum hold time for calls. By default, calls on hold or parked for longer than fifteen minutes are disconnected.

Pick up a call from an orbit

1. Click the Orbit Queue page.

2. Right-click a call in the orbit queue and choose Pickup from the menu that appears, or highlight the call then click the Pickup button. You are now connected to the call.

Note: You can also use a Polycom phone configured as SIP station to pick up a call from an orbit. See the Polycom® SountPoint® IP 300/301 SIP 1.5.3. Soft Key Features or the Polycom® SountPoint® IP 500/501 and 600 SIP 1.5.3. Soft Key Features reference guides.
Conference Calling

In Interaction Client .NET Edition, you can participate in and facilitate conference interactions (Figure 10). Interaction Client .NET Edition no longer uses a conference button or a separate dialog to handle conferences.

Conferences show up in the queue lists in a tree fashion. The initial call is the root item, next to it is a plus or minus icon, [+] or [-], that can be clicked to expand or collapse the conference display.

Create a conference session

To create a conference, drag one connected call to another, or right-click the connected call and choose Create Conference. You will see a new entry in the list entitled “Conference”.

Add someone to a conference session

To add parties to a conference call, drag and drop the connected call onto the Conference entry in the Interactions list.

Participate in a conference call using Join

1. Open the user or station queue you are monitoring.
2. Select the call or conference call you want to join.
3. Click the Join button. You are now connected to the call (or conference call already in progress).

Disconnect someone from a conference call

1. From the list of joined calls in the My Interactions list, choose the participant you want to disconnect.
2. Click the Disconnect button or right-click and choose Disconnect from the menu that appears.
Working with Voicemail

With Interaction Client .NET Edition, you receive voicemail in the same place you receive email. Any time a caller leaves a voicemail message for you, the voicemail message is attached to an email and sent to your email account.

You can open your voicemail messages from your email Inbox or you can listen to voicemail from the optional Voicemail List page in Interaction Client .NET Edition.

You can also listen to and manage your voicemail messages by using the voicemail features on your telephone.

Pick up a call from voicemail

You can pick up a call when the caller is in the middle of leaving a voicemail message. When a call is transferred to voicemail, its state changes to "Voice Mail."

To pick up a call from voicemail:

1. If the telephone call is not selected, select the call you want to pick up.
2. Click Pickup, or right-click the call and choose Pickup from the menu that appears. The call’s state changes from "Voice Mail" to "Connected" and you can begin speaking with the caller.

Listen to someone leave a voicemail message

You can listen to someone leaving a message before deciding if you want to pick up a call. The person leaving the message does not know you can hear them.

To listen to someone leave a voicemail:

1. Select a call from My Interactions that is in a state of ‘Voice Mail’.
2. On the toolbar, click the Listen button, or right-click the call and select Send to Voicemail. Through your telephone handset you can now hear the person leaving a voicemail message. If you want to talk with the caller, click the Pickup button.
**Warning:** Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or state law restrictions regarding Record or Listen capabilities of IC software. The licensee hereby warrants and represents that the end-user or licensee will use the product in compliance with any federal or state law.

**Pick up a call recording a voicemail message**

1. Highlight the call you want to pick up.
2. Click the **Pickup** button or right-click the call and choose **Pickup** from the menu that appears.

**Transfer a call to your voicemail**

If the call is alerting, click the **Voicemail** button. If the call is connected, do one of the following:

- Select the call, if it is not already selected and click the **Voicemail** button.
- Right-click the call and select **Send to Voicemail**. The call will be sent to your voicemail.

When a caller finishes the message, you are notified by email that you have a new voicemail message. You can also listen in on the call as the caller leaves a message, and then decide whether or not to pick up that call from voicemail.

**Transfer a call to another person’s voicemail**

You can transfer a call directly to another Interaction Client user’s voicemail. You might want to use this feature if the caller wants to communicate with another person who is unavailable to take the call.

**Note:** You must have permission to use voicemail features in Interaction Client .NET Edition. If you have questions about permissions or voicemail options, see your IC administrator.

This procedure assumes you are transferring calls from My Interactions, but you can transfer calls from any queue you are monitoring.

**To transfer a call to another person’s voicemail:**

1. Tell the caller that he or she is going to be transferred to another person’s voicemail.
Working with Voicemail

2. On the toolbar, click the **Transfer** button. Or right-click the call and choose **Transfer** from the menu that appears. The **Transfer** window appears.

3. In the **Transfer To:** field, enter the transfer recipient's number.

4. Click **Send to Voice Mail**. The call is transferred to the recipient’s voicemail and disappears from **My Interactions**.

Or...

1. Tell the caller that he or she is going to be transferred to another person’s voicemail.

2. Click on a directory tab and right-click the voicemail recipient.

3. Select **Transfer Connected Call**, then choose **Send to Voicemail**. The call is transferred to the recipient’s voicemail and disappears from **My Interactions**.

Understanding Unified Messaging

Unified Messaging installation is an optional part of the Interaction Client .NET Edition installation. Unified Messaging includes the Interaction Edition Fax and the Interaction Voicemail player. Contact your IC administrator, if you do not have Unified Messaging.

Faxes are managed in one of two ways in Interaction Client .NET Edition:

- If Interaction Fax is installed on your workstation, you use the Interaction Fax viewer to view, edit, print, compose and send fax documents. You receive faxes as I3F files.

- If Interaction Fax is **not** installed on your workstation, you receive faxes as TIF files and use the default application set up in Windows for TIF files to view and print faxes.

**Note:** The Interaction Administrator must configure your User rights to enable you to use TIF files for faxes. Contact your IC administrator if you do not have the Unified Messaging installed and your faxes are not being attached to email as TIF files.

Voicemail is similarly managed in one of two ways in Interaction Client .NET Edition:
• If the Interaction Voicemail player is installed on your workstation, you can open an email with a voice mail attachment, double-click the attachment, and the Interaction Voicemail player will open ready to play the voicemail.

• If the Interaction Voicemail player is not installed on your workstation when you open the email and double-click on the voicemail attachment, your Windows designated audio player (for example, Microsoft Media Player) opens and begins playing your message.

Overview of Interaction Voicemail Player
When a caller leaves a voicemail, it is stored as a .wav file on the IC server. You can access this voicemail message in three ways:

• From the Voicemail List in Interaction Client .Net Edition
• From the telephone user interface (TUI)
• By playing the .wav file with the Interaction Voicemail Player

Using the Interaction Voicemail Player
When someone leaves a voicemail for you, IC sends an email message to you with the voicemail .wav file attached to it. This message appears in your email client (e.g., Microsoft Outlook, Microsoft Outlook Express, Lotus Notes, etc.) with an attached .wav file.

When you play this attached file, by double-clicking it or downloading it then opening it the voicemail message plays in the Interaction Voicemail Player. If you are using the Interaction Message Store, just double-click on the voicemail .wav and the Interaction Voicemail Player plays the message.

The Interaction Voicemail player not only plays voicemail messages but also allows you control the playback of the message and your indicator light. The Interaction Voicemail Player also allows you to play voicemail messages back to devices such as PC speakers, a station phone on your desk or to a remote telephone number.
Understanding the Interaction Voicemail Player and .wav files

Each voicemail .wav file delivered to you has information embedded in it signifying it is a voicemail message. When you open a voicemail file, the Interaction Voicemail Player reads this information, determines it is a voicemail message and plays the file. When you open any other .wav files on your computer, the file will not have the voicemail designation and so opens in your default .wav player (e.g., Microsoft Media Player).

Interaction Voicemail Player allows you to:

- Play voicemail messages directly from electronic mail.
- Control the playback of voicemail messages.
- Clear a message waiting indicator light

Note: See the Interaction Voicemail Player online help for more details.

Configure the Interaction Voicemail Player

You determine if the Interaction Voicemail Player is your preferred application for playing back voicemail messages. You can also configure several options that control what this form does.

To configure voicemail playback, in the Interaction Voicemail Player, from the Tools menu, select Options (Figure 11).

Note: See the Interaction Voicemail Player online help for details on these settings.
Working with Voicemail

Using Interaction Voicemail Player Controls

The player controls make up the application window (Figure 12), below the menu bar. They act like VCR controls to control playback of a voicemail.

Figure 12. Interaction Voicemail Player application window

The following table lists the controls within the application window and a brief description of their functions:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play To</td>
<td>PC Speakers</td>
</tr>
<tr>
<td>Play</td>
<td>PC Speakers</td>
</tr>
<tr>
<td>Pause</td>
<td>PC Speakers</td>
</tr>
<tr>
<td>Stop</td>
<td>PC Speakers</td>
</tr>
<tr>
<td>Progress</td>
<td>PC Speakers</td>
</tr>
<tr>
<td>Options</td>
<td>PC Speakers</td>
</tr>
<tr>
<td>Screen</td>
<td>PC Speakers</td>
</tr>
<tr>
<td>Volume</td>
<td>PC Speakers</td>
</tr>
</tbody>
</table>

Figure 11. Interaction Voicemail Player Options window.
Open a voicemail message from your Inbox

You can play, replay, rewind, fast forward, save, and change the volume of the message by opening your voicemail message in your email Inbox. You can forward the message to another person, just as you would any other email message.

In addition, you can configure the alerts you receive for new voicemail messages. See Using Voicemail and Fax Paging on page 50.

**Note**: You can also listen to and manage your voicemail messages by using the voicemail features on your telephone. See Using Interaction Voicemail Player Controls on page 45.

By default, voicemail messages begin to play automatically through your computer’s speakers. If you want the voicemail messages to play only when you click on the Play button, in the Interaction Voicemail form, from the **Tools** menu, select **Options** and clear the **Play voicemail automatically on open** checkbox.
To listen to your voicemail through your Inbox:

1. Open your email Inbox.
2. Open the email containing the voicemail message.
3. Double-click the voicemail message. You use either the Interaction Voicemail Player or your selected media player to playback your message, depending on your selection in the Voicemail Player Options dialog box.

Note: See the Interaction Voicemail Player online help for details on using this player.

Use the Voicemail List

You can create a page in Interaction Client .NET Edition that enables you to view a list of current voicemails and play them on your station.

Note: Before you can use the Voicemail List, you must make it available as a page in Interaction Client .NET Edition (Figure 13).

Figure 13. Voicemail List page in Interaction Client .NET Edition.
To play back voicemails using the Voicemail List:

1. Select the Voicemail page.

2. Verify that your playback location is set correctly in the Play To dropdown list. If you select Remote Telephone, enter this remote phone number in the Number box that appears when you select this option.

   **Note:** The Remote Telephone option enables you to playback voicemail to your cell phone or other telephone. This number does not default from the remote telephone number you can configure in the Interaction Voicemail Player options.

3. To ensure that all your current voicemails appear in the list, do one of the following:
   - Click the Refresh List button.
   - Right-click anywhere in the voicemail list and select Refresh List.

4. Select a voicemail message and click the Play button.

During playback, you can also:

- Click the Stop button at any time to stop playback.
- Click a column heading to sort the voicemail list by that column.
- Adjust playback volume and speed.
- Right-click on a message and select Delete to remove the message from the voicemail list.
- Select a message and click Download to prepare the voicemail for PC Speaker playback.

   **Note:** A local copy is also saved whenever you play a voicemail message through the PC Speakers. You can right-click on a message and select Remove Local Copy to delete these downloaded voicemail messages from your local drive.
Display the Voicemail List Playback interface
The voicemail list includes a playback interface that enables you to listen to your voicemails on a choice of devices.

To display the voicemail list and player:
1. In Interaction Client .NET Edition, do one of following:
   - Right click on a tab in the zone where you want to add the Voicemail list page and click Pages...
   - Right click on the blank part of the area where tabs appear in the zone where you want to add the Voicemail list page and click Pages.... The Client Pages dialog box appears.
2. In the Client Pages window, select Voicemail.
3. Place a checkmark in the (Private) Voicemail box.
4. Click Apply to save your selection.
5. Click OK to close the Client Pages window.
Using Voicemail and Fax Paging

In Interaction Client .NET Edition, you can configure the alerts you receive for new voicemail messages.

Set voicemail alert options

1. To set voicemail and fax alert options, from the Options menu, click Configuration..., click the Alerting node and click Voicemail and Fax Paging.
2. In the Voicemail / Fax Paging page, complete the fields as described in the following Voicemail/Fax Paging options.
3. Click OK to close the Configuration window.

Voicemail and fax paging options

Administrators can lock configuration options so that they cannot be changed by individual users. If the menu options on your configuration pages are grayed-out, you do not have permission to modify them. If you have questions about configuration options and permissions, see your IC administrator.

Alerting method

Choose one of the following options in the Alerting Method section:

- **Do Not Send Me Alerts**: Choose this radio button if you do not want to receive alerts when you have messages waiting.
- **E-Mail Address**: Choose this radio button to receive alerts at an email address. Enter the email address in the text field next to the selection. This can either be a standard email address or an email address that resolves to a pager.
- **Telephone Number**: Choose this radio button to receive alerts at another telephone number. Enter the telephone number in the text field next to the selection. You can type both commas (,) and slashes (/) with the number you type. Comma causes a two-second delay and numbers typed after the slash are dialed only after a connection is made. For example, if you typed the number "555-1212 / 101, 2222", the first seven digits are dialed. After a connection is made, the digits 101 are dialed, and after two seconds, the digits 2222 are dialed.
• **Note:** Use of the comma (,) to create a two-second delay is not supported in all platforms. This issue will be resolved in a future release.

• **Pager Number:** Choose this radio button to receive alerts on a pager. Enter the pager number in the text field next to the selection. You must also enter your pager ID in the **Pager ID** field. See your IC administrator for your pager ID number. If you use this method, you receive text messages that include the remote telephone number and the date and time of the call.

**Alerting reason**
Select your reasons for an alert in the **Alerting Reason** section:

- **I Receive a Voicemail:** Choose this option to receive an alert for new voicemail messages. If you want an alert every time you receive a voicemail, click the **Any Voicemail** radio button. If you want an alert only when you receive a voicemail marked urgent, click the **Only Urgent Voicemails** radio button.

- **I Receive a New Fax:** Choose this option to receive an alert for new fax messages.

**Alerting time**
Select the times when you want to receive alerts in the **Alerting Time** section:

- **Any Time of Day:** Choose this radio button to receive an alert any time of day that you receive a message.

- **Only Between:** Choose this radio button to receive an alert only during specific hours you choose. Click the arrows at the end of the **Start** box and choose the earliest time you want to be contacted. Click the arrows at the end of the **End** box and choose the latest time you want to be contacted.
Working with Email

You can access email (Figure 14) from your My Interactions queue, or any other queue you are monitoring in the Interaction Client .NET Edition window.

While email access is a standard feature in Interaction Client .NET Edition, you must be licensed to use it, and you must be assigned to a workgroup set up to manage emails. See your administrator if you have any questions regarding the email feature and whether or not you have access to use it.

You can also respond to and transfer an email message. You can send a response with or without attachments, URLs, and files to your response.

**Note:** If your original email contains an attachment, it will automatically remain attached to the email when you transfer it. You cannot delete original email attachments.

![Email dialog box](image-url)
When you pick up an email message, the email state changes to ACD Assigned: (Agent name), and other agents won’t be able to respond to the message. However, if the email is transferred to you, or if you pick up an email even though you are a non-member of the workgroup, the email state changes to Connected.

As in all interactions, the email will remain in the workgroup queue unless a non-member of the workgroup picks it up. If a non-member of the workgroup picks up the email message, it will disappear from the workgroup queue.

Agents or supervisors who view a read-only version of the email before you type a response won’t see your updates until you save or send the response.

Use the Notes tab to add any notes or comments you want other agents or supervisors who pick up or view this email message to read.

The following instructions outline the most common email tasks.

---

**Pick up or reopen an email**

1. In your My Interactions queue or any other queue in which the email interaction is alerting, highlight the incoming email. An email interaction in your queue is preceded by an email icon (֒וא). **Note:** You can pickup an email on your queue because it was assigned to you by browsing a workgroup queue and selecting the email. You may also pick up an email assigned to someone else, if you determine that a particular circumstance requires you to do so.

2. To pick up or reopen the email, double-click it, or highlight the interaction and click the Pickup button or press Ctrl+P.
Working with Email

Reply to an email

1. On the email form, in the To, Cc, and Bcc boxes type the names of the email recipients.

   **Note**: Unlike other email forms, you do not need to separate email addresses with other characters. Simply type the names of the email recipients and the form will automatically place semi-colons between the email addresses. If you try to separate recipient names with a semi-colon or other non-alphanumeric character a window will open, requiring you to search for an address.

2. Type a message in the response area.

3. To optionally attach a file to the email, open the **File** menu and choose **Insert attachment**, or press **Ctrl+I**. Or you may drag a file to the email form to attach it.

4. To optionally add notes to the email, click the **Notes** tab on the right side of the window and type your information.

5. Optionally save the email:
   - To save the sender’s original attachments to the directory you choose, open the **File** menu and click **Save original attachments**, or press **Ctrl+O**.
   - To save attachments you send with the email to directory you choose, open the **File** menu and click **Save response attachments**, or press **Ctrl+A**.
   - To save the email response, open the **File** menu and click **Save response**, or press **Ctrl+S**.

6. To print or fax your email, press the **Print** button.

7. To send the email, press the **Send** button. The email will disconnect and become read-only.
Transfer an email

If you transfer an email and the transfer recipient doesn’t answer, Interaction Client .NET Edition returns the email to your user queue and places it on hold.

1. Open the email.
2. In the email window, click the **Transfer** button. The **Transfer** window opens.
3. In the **Caller** field, optionally type a descriptive sender name.
4. In the **Transfer To:** field, type the extension of the person or workgroup to whom you want to transfer the email.
5. Click the **Transfer Now** button.

   **Note:** You can also drag and drop an email onto a name in a directory. The email will automatically be transferred to the recipient.

Automatic email spell-checking

Interaction Client .NET Edition automatically spell-checks text in the email window. Anything the system determines as misspelled will appear with a red underline beneath it. You can right-click the text in question to view other spelling options, such as ignore or add the word, or to insert another word to replace the misspelled one.
Working with Account Codes

In Interaction Client .NET Edition, you can use account codes to organize telephone interactions by customer. You may find this feature useful for customer billing purposes, or if you process interactions through IC for more than one company. Your system administrator can generate reports to categorize call details by account codes.

You can assign account codes to incoming and outgoing interactions from the Interaction Client .NET Edition window, or from any Interaction Object (such as email, chat sessions, or callback objects).

Account Code fields do not appear if you have not been granted permission to use this feature. See your administrator if you have any questions regarding your account code rights.

When working with account codes, it is important to note the following restrictions:

- You cannot split an interaction between account codes.
- You can only assign one account code per interaction.
- You cannot assign, change, or delete an account code after it disappears from your queue unless you have permission to modify in the queue to which the interaction transfers.
- You can assign account codes numerically. See Numerically sort account codes on page 59. When you type the first few numbers of the account code, Interaction Client .NET Edition jumps ahead to the first match, allowing you to quickly select the appropriate code for your interaction.
- You can use the Properties window to set an account code for any incoming or outgoing interaction, but you can only use the Account Code dropdown menu for outgoing interactions when you use the Number: field and Make Call button. You can also use the Account Code dropdown menu when you drag and drop an entry from an IC directory to the Number: field.
Assign an account code to an incoming interaction

1. Highlight the incoming interaction and click the **Pickup** button, or pick up your telephone handset.

2. Right-click the interaction and choose **Properties** from the menu that appears. The **Interaction Properties** window opens (Figure 15).

3. In the **Interaction Properties** window, click the arrow at the end of the **Account Code** field and highlight the account code you want to assign to this interaction.

4. Click the **x** in the top right corner of the **Interaction Properties** window to close it. The code you assigned to the interaction appears in the **Account Code** column of your queue.

Assign an account code to an Interaction Object

You can assign an Account Code to the following Interaction Objects:

- Email session
- Chat session
- Callback Object

For example, while participating in a chat session, in the Chat window click the arrow at the end of the **Account Code** field and highlight the account code you want to assign to this chat session.
Assign an account code to an outgoing interaction using the Account Code field

The Account Code field is disabled when the Number field is empty. You must enter the recipient’s telephone number before you enter the account code.

**Note:** You can use the Properties window to set an account code for any incoming or outgoing interactions, but you can only use the Account Code dropdown menu for outgoing interactions when you use the **Make Call** button, **Number:** field, or drag and drop from an IC directory.

1. Open Interaction Client .NET Edition and in the **Number:** field, type the phone number you want to call.

   **Note:** You can also drag and drop a directory entry into the **Number:** field. The system will copy the contact’s default number into the **Number:** field.

2. Click the arrow at the end of the **Account Code** field and highlight the account code you want to assign to this interaction.

3. Click the **Make Call** button or press **Enter**. The code you assigned to the interaction appears in the **Account Code** column of your queue.

Assign an account code to an outgoing interaction using the Properties window

1. Open Interaction Client .NET Edition and in the **Number:** field, type the phone number you want to call.

   **Note:** You can also drag and drop an IC directory entry into the **Number:** field. The system will copy the contact’s default number into the **Number:** field.

2. Right-click the interaction and choose **Properties** from the menu that appears. The **Interaction Properties** window opens (Figure 15).

3. In the **Interaction Properties** window, click the arrow at the end of the **Account Code** field and highlight the account code you want to assign to this interaction.

4. Click the ✗ in the top right corner of the **Interaction Properties** window to close it. The code you assigned to the interaction appears in the **Account Code** column of your queue.
Assign an account code to an outgoing interaction from the handset
1. Lift your handset and dial the phone number.
2. Press the * key.
3. Enter the account code you want to assign to this interaction.

Numerically sort account codes
You can sort your list of available account codes numerically. This option allows you to quickly and easily search for the appropriate account code to assign to your current interaction.

To numerically sort your account code list:
1. Open the Options menu and choose Configuration....
2. In the Configuration window, on the left side of the window click the General node.
3. On the right side of the window, place a checkmark in the Sort account codes by account number box.
4. Click OK to save your changes.
Understanding wrap-up codes

In Interaction Client .NET Edition, you can use wrap-up codes to indicate the nature of an interaction; for example, a billing problem, a new order, or a service request.

These wrap-up codes are defined by your administrator and will be used in reports specific to wrap-up codes. Your administrator can configure them on a per-workgroup basis. Your administrator can also generate reports to categorize call details by wrap-up codes.

You can assign wrap-up codes to incoming and outgoing interactions from the Interaction Client .NET Edition window. You can also assign or change a wrap-up code any time during an interaction.

If you have questions about your wrap-up code permissions, see your system administrator.

When working with wrap-up codes, it is important to note the following restrictions:

- You cannot split an interaction between wrap-up codes.
- Wrap-up codes are specified on a workgroup, therefore they only apply to ACD (Automatic Call Distribution) interactions.
- You can only assign one wrap-up code per interaction.
- You cannot assign, change, or delete a wrap-up code after it disappears from your My Interactions queue.
- You cannot sort wrap-up codes by code or name; they are automatically sorted alphabetically by description.
- When you type the first few characters of the wrap-up code or name, Interaction Client .NET Edition jumps ahead to the first match, allowing you to quickly select the appropriate wrap-up code.
- Wrap-up codes do not have a default value. If you don’t select one of the pre-defined wrap-up codes, no code is assigned.
The wrap-up code feature contains an optional window that remains open to remind you to enter an appropriate code. Whether or not this window appears in your Interaction Client .NET window is configured in Interaction Administrator. Your administrator can also set up the length of time the window remains active before automatically closing. See your system administrator if you have questions about this feature.

**Note:** The reminder window also closes when you enter a wrap-up code to assign to the interaction.
Understanding Generic Object Routing

Some companies may incorporate tasks specific to the organization into Interaction Client .NET Edition, and as such may implement the ability to route these ACD queue objects to agents or users within a workgroup. While most interactions (phone calls, emails, chat sessions, and so on) generally involve communication between two or more people, generic objects are more task-based, unlike interactions that require some type of contact with another person.

For example, a generic object may include a request to author a knowledgebase entry, a loan application for processing, a CRM ticket, and more. Just as with any other interaction, you can pick up, transfer, disconnect, request assistance with, or place on hold generic objects. Supervisors may view the status of individual tasks and team members through Interaction Supervisor.

Your company may or may not implement this feature. If you have questions about sending and receiving generic objects, or tasks other than general interactions, within Interaction Client .NET Edition, see your system administrator for details.
Monitoring Other Users

A user can set up Monitored Appearances to observe the activity of several personnel at the same time. This feature is particularly helpful if a person has a number of personnel for which he or she manages calls.

Monitored Appearance entries appear on the Interactions page (Figure 16), and have a different background color than the rest of the page to help a user view and facilitate interactions for that monitored user.

For example, receptionists or secretaries can use Monitored appearances to continuously observe a manager’s queue, control interactions, and perform tasks on his or her behalf, such as picking up or transferring calls and creating conferences.

You can see the status of monitored users at-a-glance, as well as set distinguishing characteristics to alert when a monitored user performs particular tasks, such as engaging in a telephone call. These alerts can include visual pop-ups, audible alerts, or both. Use the Configuration page to create Monitored Appearances.

Figure 16. Monitored Appearances area in the Interaction Client .NET Edition window.

Figure 17. Configure Monitored Appearances.
Monitoring Other Users

Set up monitored appearances
1. Open the **Options** menu and choose **Configuration**.
2. In the Configuration menu, click Monitored Appearances.
3. In the Monitored Appearances area, click Add. The Add Monitored Appearance window opens.
4. Click the arrow at the end of the **Queue:** drop-down box and choose a user to monitor. In the **Label:** box, type a unique name for the monitored user, then click **OK**.
5. To add more users, repeat steps 3-5.
   **Note**: You can also drag and drop users from the Company Directory (or any other available directory) to your My Interactions area to quickly create a monitored appearance.

Customize monitored appearance alerts
1. Open the **Options** menu, choose **Configuration**..., click Monitored Appearances and in the **Monitored Appearances** area, choose the user whose alerts you want to configure.
   Or, on the client window in the **Monitored Appearances** area, right-click the user whose alerts you want to configure and choose **Configuration**... from the menu that appears.
2. Configure your monitored appearance alert options:
   - If you chose a user from the **Configuration**... window and this user did not already exist in the **Monitored Appearances** area of your Interaction Client .NET Edition window, to place the user in your active list of monitored users, place a checkmark in the **Active** box.
   - If you want your phone to ring when a monitored user receives a phone call at his or her extension, click the **Ring telephone for calls** box.
• If you want to receive an audible alert through your computer’s speakers when the monitored user receives a telephone call at his or her extension, click the **Ring computer** box. If you also check the **Ring when on phone** box, incoming calls for the monitored user ring on the computer when he or she is already on the phone.

• If you want Interaction Client .NET Edition to appear on top of any other application you are running when the monitored user receives an incoming interaction, check the **Pop Client** box.

• To change the ring tone alert for the monitored user, in the **Call Ring Sound** area click the … button to browse for different ring tones.

3. Click **OK** to save your changes and return to the Interaction Client .NET Edition window.

### Rename a monitored appearance alert

1. Open the **Options** menu, choose **Configuration…**, click **Monitored Appearances** and in the **Monitored Appearances** area, choose the user whose alerts you want to configure.

   Or, on the client window in the **Monitored Appearances** area, right-click the user whose alerts you want to configure and choose **Configuration…** from the menu that appears.

2. To change the way the name appears in your Monitored Appearances area of client window, in the **Label:** area type a new name.

3. Click **OK** to save your changes and return to the Interaction Client .NET Edition window.
Monitoring Other Users

Remove a monitored appearance alert from your client window
1. Open the Options menu, choose Configuration..., click Monitored Appearances and in the Monitored Appearances area, choose the user whose alerts you want to configure.

Or, on the client window in the Monitored Appearances area, right-click the user whose alerts you want to configure and choose Configuration... from the menu that appears.

2. In the Active box, click to remove the user from your active list of monitored users.

3. Click OK to save your changes and return to the Interaction Client .NET Edition window.

Permanently delete a monitored appearance alert
1. Open the Options menu, choose Configuration..., click Monitored Appearances and in the Monitored Appearances area, choose the user whose alerts you want to configure.

Or, on the client window in the Monitored Appearances area, right-click the user whose alerts you want to configure and choose Configuration... from the menu that appears.

2. To delete and completely remove this user from your list of available monitored users, highlight the user and click the Remove button.

3. Click OK to save your changes and return to the Interaction Client .NET Edition window.
Implementing Personal Rules

You can use personal rules to automatically manage interactions. After you create a rule, Interaction Client .NET Edition applies the rule when interactions arrive in My Interactions. For example, you can automatically display a desktop alert when you receive a call from your boss. You set the conditions which control how a rule is triggered, when it runs, and what it does.

Create a personal rule

1. From the Options menu, click Rules, and in the Personal Rules dialog box, click New.
2. In the I want this rule to be based on: section of the Rule Wizard, select one of the following:
   - Template: Build a rule based on a template. Note: A template is a pre-built rule based on an event with various conditions, actions, and exceptions that you can customize using the Rule Wizard.
   - An Event: Build a rule based on an event such as "When I receive a call."
3. Select a template or an event from the displayed list. The default rule conditions appear in the lower part of the Rule Wizard. Next, perform either or both of these optional steps or skip to the next step:
   - Name: Change the rule name by typing over the default name in this text box.
   - Turn on Rule: Clear this checkbox to suspend the processing of this rule at this time.
4. Define any attributes in the rule conditions, then click Next and further define the rule in the Rule Wizard. There are three pages in the Rule Wizard. They define rule conditions, actions, and exceptions. For each page:
   - Select the checkbox for any item you want to include in the rule.
   - Clear the checkbox to remove an item from the rule.
   - Supply required attribute names or values.
5. On the 1st Page: In the When should the rule run? page, select checkboxes for conditions that cause the rule to run. Supply required attribute names or values. Click Next.
Implementing Personal Rules

6. On the 2nd Page: In the What do you want to have the rule do? page, select checkboxes for actions you want performed when the rule runs. Supply required attribute names or values. Click Next.

   Note: A rule must have at least one action. Actions are performed in top to bottom order. Use the up and down arrows to change the order in which actions are performed in the rule.

7. On the 3rd Page: In the Are there any exceptions when the rule should not run? page, select checkboxes for exceptions to the rule that cause it not to run. Supply required attribute names or values. Click Next.


9. Click OK to close the Personal Rules window.

Understanding attribute names and values

Attributes are information tags attached to an Interaction in the system. Attributes have names and values. IC uses attributes to contain most of the data about an interaction. In addition, your IC administrator can add custom attributes to an interaction as part of the call handling on the server. In Personal Rules, attributes can be used to further define rule conditions.

- Rules that require attribute names have the hyperlink `<attribute name>` in them. Click `<attribute name>` and supply the name of the desired attribute before continuing to the next Rule Wizard section.

- Rules that require an attribute value have a hyperlink with the attribute name inside it (example, `<status>`, `<time>`, or `<phone number>`).
Specify an attribute name or value
1. Click any `<attribute name>` or `<attribute value>` hyperlink displayed in the rule conditions.
2. Enter the attribute name or select an attribute value in the attribute-specific dialog box that appears.
3. Click OK to save the attribute name or attribute value.

Play audio files to caller
1. When you create a personal rule, select an action such as "play <audio file> to the caller" or "ring my PC with <audio file>.”
2. Click the `<audio file>` hyperlink displayed in the rule conditions. The Audio Files dialog box is displayed.
3. In the File Name list, select an audio file from your personal storage area.

Or if the file you want is not listed, click Manage. In the Personal Storage Management dialog box, click Add. In the Open dialog box, locate the appropriate .wav file and click Open. Click Close.
4. In the Audio Files dialog box, click OK. The name of the selected audio file appears in the rule condition.

Copy a personal rule
1. In the Personal Rules dialog box, select a rule.
2. Click Copy.
3. Click Edit to make changes to the copied rule, or click OK to save the copy and close the Personal Rules dialog box.

Edit a personal rule
1. In the Personal Rules dialog box, select a rule.
2. Click Edit.
3. Make any necessary changes.
4. Click Finish.
5. Click OK to close the Personal Rules dialog box.
Implementing Personal Rules

Rearrange personal rule processing order
1. In the Personal Rules dialog box, select a rule.
2. Click the up or down arrows to the right of the rule list to move the selected rule to a new position in the list.
3. Click Apply to save the rule processing order.
4. Click OK to close the Personal Rules dialog box.

Turn a personal rule on or off
You can suspend the processing of a selected rule without removing it from the rule list in the Personal Rules dialog box. Rules that are on have a checkmark to the left of the rule name. Click this checkbox to turn a rule on or off.

Delete a personal rule
1. In the Personal Rules dialog box, select a rule, and then click Delete.
2. In the Client Rules dialog box, click Yes.
3. Click OK.
Setting Up Desktop Alerts

Use Desktop Alerts to display a desktop dialog box for alerting interactions and camped calls. The Desktop Alert dialog box (Figure 18) pops up in the bottom right corner of your Windows desktop. The dialog box fades automatically depending on the type of alert. To stop the fading, move the mouse over the dialog box.

Figure 18. Desktop Alert.

1. Open the **Options** menu, choose **Configuration...**, open the **Alerting** node, and then click on **Desktop Alerts**.

2. In the **Desktop Alerts** page, complete the fields as described below.

   - **Display Desktop Alerts for Alerting Interactions**: Select this checkbox to turn on desktop alerts. The Interaction Alert dialog box displays information about the interaction, i.e., name, number and an icon for the interaction type (call).

     **Note**: You can also display a message in a desktop alert dialog box by setting up a personal rule.

   - **Duration**: Adjust the slider to control how long the Interaction Alert dialog box is displayed on the desktop before fading away. Set the alert to fade immediately (0 Seconds after alerting), never (Lifetime of Interaction), or a time between 1 and 120 seconds.

3. Click **OK** to close the **Configuration** dialog box.
Setting Page Options

Use the **Client Pages** window (Figure 19) to add the directory and queue pages you want to display on your Interaction Client .NET Edition, including speed dial pages, personal and public contacts, and call history.

![Client Pages window](image)

**Figure 19. Client Pages window.**

---

Add a page to the Interaction Client .NET Edition window

1. Open the **Options** menu and choose **Pages...**. The **Client Pages** window opens.

   Or right-click anywhere in the Interaction Client .NET Edition pages area and choose **Pages...** from the menu that appears. The **Client Pages** window opens.

2. From the **Categories** list, select the type of page to display. The available pages within that category appear in the **Pages** list.

3. In the **Pages** list, place a checkmark in the box next to the page(s) you want to add.

4. Click **OK** to close the Client Pages window, then click **OK** again to close the **Configuration** window.
Manually set page options

- **To change the order of the pages:** Click and hold on the tab for the page you want to move. Drag and drop the tab in its new position on the tab line (on top of the tab currently occupying the target position.)

- **To add or remove columns from a page:** Right-click on the column headings for the page. (A drop-down list of available column names appears.) Do one of the following. To add a column to the Call History page, click the name of a column. To remove a column, click the name of a column with a checkmark.

- **To remove a page:** Right-click on the tab for the page you want to move. Select **Remove Page** from the drop-down menu that appears.

- **To change the size of a folder region:** To change the width, point to the left or right area between the folder regions. When the pointer changes into a resize icon, drag the border to the right or left.

- **To change the height:** Point to an area between the center regions. When the pointer changes into a resize icon, drag the border up or down.
Changing the Page Layout

Using a flexible docking architecture, you can rearrange pages within the Interaction Client .NET window, placing them in more convenient locations to suit your needs.

This capability is helpful if you manage many interactions and users, for example in different states or multiple inter-office divisions, because more pages can be visible at a time than in previous versions of Interaction Client .NET Edition.

To move a page, click the tab with your mouse and start dragging it. Docking arrows appear on the client window (Figure 20), showing you the available locations to which you can move the page.

When you move the mouse on top of an arrow, the client highlights the area to which the page will move if you release your mouse and “drop” it on that particular docking arrow. You can also drag a page within its current set of tabs to reorder it.

**Note:** In the Interaction Client .NET Edition, when you click a tab to select a page, that page will contain a focus indicator icon ( ), which helps the user see what page will receive keyboard input, or in this case, the page to be moved.

![Docking icons](image)

**Figure 20. Docking arrows.**
Move a page to a new location

1. In the Interaction Client .NET Edition window, click and hold the tab you want to move. The docking icons appear, as shown in Figure 20.

2. Without letting go of the mouse button, move the mouse over the icon that represents where you want to move the page.

   **Note:** The Interaction Client .NET Edition highlights the area to which the page will move.

3. Release the button to drop the page into its new location. The page automatically moves to the chosen area.

**Example: Moving a page to a new location**

In the following example, the user wants to move the *Sales directory* (Figure 21) to a new location—the right side of the Interaction Client .NET Edition window.

**Note:** Notice the *Sales directory* tab contains the focus indicator icon ((mutex).)
Changing the Page Layout

The user clicks the Sales directory tab and drags it over the Interaction Client .NET Edition window, which will display the docking icons.

Ultimately, the user chooses to release the mouse and drop the page onto the docking arrow on the far right side of the Interaction Client .NET Edition window. The Sales directory now appears on the right side of the client window (Figure 22).

![Interaction Client .NET Edition](image)

**Figure 22. Example: Sales directory after moving it to a new location.**

**Turn off the ability to dock or rearrange pages**

Some users may find they do not want to rearrange pages, or don’t want to accidentally move a page in the middle of an interaction. Interaction Client .NET lets you to control the ability to drag and drop pages in the client window, depending on your requirements.

To turn off the drag and drop feature, open the Options menu and choose Lock the Pages. A checkmark appears next to this option, indicating that the pages are locked into place and cannot be moved to a new location.

If you decide you want the ability to rearrange pages, simply repeat these steps to remove the checkmark next to Lock the Pages.

**Return to a default page layout**

Resetting the page layout restores your Interaction Client .NET Edition to its default set of pages and the default layout for those pages.
To return to a default page layout:

1. Open the **Options** menu, choose **Configuration...**, and in the **Configuration** window, click **Pages**.

2. In the **Client Page Layout** area, next to the page layout drop-down menu click the **Reset** button.

3. A **Configuration** window appears, asking you to confirm that you wish to return the layout to its default settings. To continue, click **Yes**. To cancel, click **No**.

4. Click **OK**. Your Interaction Client .NET Edition pages are automatically restored to their original configuration.
Working with Speed Dial Pages

Speed dial pages provide a quick way for users to dial frequently called contacts. The entries within a speed dial page show the directory contact associated with it, along with an icon that shows the number the system will dial if you double-click the entry.

When you right-click a speed dial entry, a menu appears, offering you options such as dialing, emailing, camping, viewing properties, and changing status; similar to the menu shown if you right-click a directory contact on a directory page.

When a user creates a speed dial page, he or she determines whether or not the page is private or public. Private speed dial pages are visible only to the user that creates the page, and public speed dial pages are visible to other Interaction Client .NET Edition users.

Speed dial entries appear inside the speed dial page. Figure 23 shows an example of a typical speed dial page.

![Figure 23. Speed dial entry.](image-url)
Understanding speed dial hyperlinks

Speed dial contacts within a speed dial page appear as hyperlinks. When a speed dial hyperlink is enabled, the contact name is blue in color and is underlined, just as a typical hyperlink would appear.

When a user clicks an enabled hyperlink, Interaction Client .NET Edition dials the default telephone number associated with that contact.

Add an existing speed dial page

1. Right-click a tab in the section of the Interaction Client .NET Edition window where you want the speed dial page to appear and choose Pages… from the menu that appears. The Client Pages window opens.

2. In the Categories area, click Speed Dials. A list of available pages will appear in the Pages section on the right side of the window.

3. In the Pages area, place a checkmark next to each speed dial page you want to add to the client window.

4. Click OK. In the Interaction Client .NET window, a tab appears for each speed dial page you decided to display.
Create a new speed dial page

1. Right-click a tab in the section of the Interaction Client .NET Edition window where you want the speed dial page to appear and choose Pages... from the menu that appears. The Client Pages window opens.

2. In the Categories area, click Speed Dials. A list of available pages appear in the Pages section on the right side of the window.

3. In the Pages area, under the list of speed dial pages click the New button. A Speed Dial window opens to allow you to set up your new speed dial page.

4. In the Name: field, enter a unique name for your new speed dial directory.

5. If you want others to add your speed dial page to their Interaction Client .NET Edition window, check the Public box.

6. If you decide to make the speed dial public, choose what options you wish to grant other users for this speed dial box:
   - If you want to allow other users to add additional entries on the speed dial page, check the Add Entries box.
   - If you want to give users the ability to edit the default number assigned to entries on this speed dial page, check the Change Entries box.
   - If you want to allow users to remove entries from this speed dial page, check the Delete Entries box.
     **Note**: Use caution when granting others the ability to delete speed dial entries. Once someone removes the last speed dial entry from a speed dial page, the system permanently deletes the speed dial page and it cannot be recovered. It is important to consider the possibility that another user may accidentally delete the last speed dial entry and you’ll have to recreate the page if you wish to keep it on your client.
   - If you want to allow users the ability to change the name of this speed dial page, check the Rename the Speed Dial box.

7. To create the new speed dial page, click OK. The new page will be added to the Pages list on the Client Pages window.
8. To add your new speed dial page to your
Interaction Client .NET Edition window, check
the box next to it in the Pages list and then
click OK.

Add contacts to a speed dial page
To add a contact to a speed dial page and
create a new speed dial entry for it, highlight
the contact on a directory page, then drag and
drop it onto the tab of the speed dial page.

Note: You can only add contacts to a speed dial
page that come from general directories. To
view a list of general directories, right-click a
tab in the section of the Interaction Client .NET
Edition and choose Pages... from the menu that
appears. The Client Pages window opens. In
the Categories list, click to expand the
Directory node and then click General
Directories. A list of available directories
appears in the Pages list on the right side of
the window.

Updating a speed dial entry’s contact
information
If you have been granted permission from your
system administrator, you can edit a speed dial
entry’s default number (the number you want the
system to dial first).

To edit any other information about the speed dial
entry, you must make those changes in the contact’s
primary source directory.

For example, let’s assume you created a speed dial
page and added a contact from your IC Private
Contacts directory. If you need to update the
contact’s business phone number, you must make the
change on the IC Private Contacts page and not from
the actual speed dial entry.
Working with Speed Dial Pages

Edit the speed dial contact’s number you want the system to dial first
If you want to edit a speed dial entry, you must be the owner of the speed dial directory or you must have permission from the owner to edit entries.
1. Right click the speed dial entry and choose Set Default Number.
2. From the menu that appears, choose the new default telephone number; for example Mobile, Extension, Business, or Home. If a menu item is disabled, such as Business 2, then no Business 2 phone number is defined for the directory contact.

Call a speed dial contact
To call a contact in your speed dial page, simply click the speed dial entry’s hyperlink and the system will dial the default telephone number assigned to the contact.

Use drag and drop to transfer calls to a speed dial entry
Users can drag and drop calls onto a speed dial entry, making the transfer of calls much quicker and more efficient.

Delete a speed dial entry
If you want to delete a speed dial entry, you must be the owner of the speed dial directory or you must have permission from the owner to delete entries.
To remove a speed dial entry from your speed dial page, right-click the entry and choose Delete Entry from the menu that appears.

Refresh a speed dial entry
To refresh the contents of a speed dial page, right-click a speed dial entry, or in the blank area of the speed dial page, and choose Refresh Directory from the menu that appears.
Rename a speed dial page

1. Right-click a tab in the section of the Interaction Client .NET Edition window where the speed dial page is located and choose Pages... from the menu that appears. The Client Pages window opens.

2. In the Categories area, click Speed Dials. A list of available pages will appear in the Pages section on the right side of the window.

3. In the Pages area, click the speed dial page you want to rename. If you have permission to rename the speed dial page, the Edit button will appear active, and not grayed out or disabled.

4. Click Edit. The Speed Dial window opens.

5. In the Name: field, enter the new name for the selected speed dial directory and click Rename.

Resize the width of speed dial entries

In Interaction Client .NET Edition, you can adjust the size of speed dial entries. When you resize one speed dial entry, all other entries on the speed dial page will also be resized to match the entry you adjust. Interaction Client .NET Edition applies changes to the width of speed dial entries on a page-per-page basis, so different speed dial pages can have different widths for the entries within each page.

For example, if your Interaction Client .NET Edition window contains two speed dial pages, Private Contacts and Marketing, and you adjust the width of one entry in the Private Contacts speed dial page, the width of all other entries in that speed dial page will automatically resize to match the width of the first entry you resized. However, no width changes will be applied to entries in the Marketing speed dial page.
Working with Speed Dial Pages

To adjust the width of a speed dial entry and, in turn, all entries within the speed dial page:

1. Move your mouse to the right edge of a speed dial entry. If a speed dial entry can be resized, the cursor will change from an arrow to a resizing cursor (↵).  
2. When the resizing cursor appears, left-click and hold your mouse button, then move it to resize the entry until it is in the position you want.
3. When the entry reaches the desired width, release your mouse. All entries on the page will be resized to match the width of the entry you changed.

**Note:** Interaction Client .NET Edition stores these customizations locally on your version of the client. Resizing the width of speed dial entries on your Interaction Client .NET Edition does not affect the speed dial entry sizing of other users who may have the same speed dial page on their client.
Working with Chat Sessions

In Interaction Client .NET Edition, chat sessions are online, real-time, typed conversations between Interaction Client users or between an Interaction Client user and a remote chat participant browsing your website. If Interaction Center is configured to receive chat sessions, you may be alerted to a chat session, just as you are alerted to other incoming interactions.

There are two types of chat sessions:

- An IC user to IC user chat is an **Intercom chat**. These internal chats can take place only between IC users on the same IC server. Intercom chats are not limited to two participants and can include several IC users. Use them to get a quick answer to a question or to pull a team together to work collaboratively on a problem.

- An IC user to remote participant chat is a **Web chat**. The remote user initiates the chat by clicking a link on the company’s web site. This chat request can be handled much like an incoming call and be ACD-routed to your queue where you pick up the chat similar to how you answer an incoming call.

A chat session is similar to a phone conversation, only information is typed, not spoken. The chat session is managed inside a chat window (Figure 24), which appears when you pick up a chat request. A remote chat participant has a chat window similar to yours.

![Figure 24. Chat window.](image)
**Working with Chat Sessions**

**Note:** Double-click the alerting chat icon 📣 in My Interactions to pick up a chat request.

In the Chat window, you can:

- Type your message in the blank box next to the **Send** button, then click the **Send** button (located on the right side of the Composition area) or press **Enter** to send that text to the other chat participant. Or press **Ctrl+Enter** to insert a line break.

- Determine who is participating in the chat by checking the names in the **Chat Members:** box in the **Chat** window. Notice also, that **(typing)** appears after the name of a chat member who is typing a message that hasn't yet appeared in the **Chat** window.

- Manage your session and perform many different functions within the chat by using the menu options at the top of the **Chat** window, or by pressing the buttons on the button bar.

- Copy text from your chat window to the clipboard. A remote participant in a **Web chat** can also do this, if the remote user's browser supports this feature.

- Add notes to the chat session. These notes are not seen by other the chat participants. This feature may be helpful for supervisors or other IC users who may review or participate in this chat session.

- Assign an Account Code or Wrap-up Code to this interaction.
**Manage a chat session**

Interaction Client users can participate in intercom chats or web chats. Chat sessions can include two or more users. You use the toolbar or menus in the Chat Window to manage the chat session.

**Chat window toolbar**

The Chat window toolbar contains buttons for most of the functions you need to manage a chat session.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Click <strong>Pickup</strong> to connect to the current chat session.</td>
</tr>
<tr>
<td>🕒</td>
<td>Click <strong>Hold</strong> to place the chat session on hold. You may want to use this option if you want to free yourself up to take other interactions. When you place a chat session on hold, Interaction Client can send you another phone call, email, or chat session.</td>
</tr>
<tr>
<td>📚</td>
<td>Click <strong>Transfer</strong> to transfer the chat session to another Interaction Client .NET Edition user or workgroup. When you transfer a chat session to another user, IC includes the existing chat conversation with the transfer, which enables the transfer recipient to review the transcript prior to joining the chat.</td>
</tr>
<tr>
<td>☑️</td>
<td>Click <strong>Voicemail</strong> to send the chat session participant or requestor to voicemail.</td>
</tr>
<tr>
<td>✖️</td>
<td>Click <strong>Disconnect</strong> to disconnect the current chat session.</td>
</tr>
<tr>
<td>🔊</td>
<td>Click <strong>Record</strong> to record the current chat session. This recording is saved and sent to you as an email attachment after you end the chat session. Clicking <strong>Record</strong> the first time starts the recording session for an interaction. Clicking <strong>Record</strong> again stops the recording session for an interaction.</td>
</tr>
</tbody>
</table>
### Working with Chat Sessions

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="" alt="Pause" /></td>
<td><strong>Click Pause</strong> to pause the recording session. Click it again to resume it session. This button appears shaded if the interaction is not in a state in which this action can be performed.</td>
</tr>
<tr>
<td><img src="" alt="Private" /></td>
<td><strong>Click Private</strong> to prevent other users from recording or listening to your conversation. This button appears shaded if the interaction is not in a state in which this action can be performed. <strong>Warning</strong>: Use of the Private feature may be subject to your company’s policies and should only be used in accordance with those policies. IC handler customization can be used to track the use of the Private feature to ensure compliance with such policies.</td>
</tr>
<tr>
<td><img src="" alt="Assistance" /></td>
<td>If you’re in a workgroup and you need help with a chat session from your workgroup queue, click <strong>Assistance</strong> to request assistance from your supervisor.</td>
</tr>
</tbody>
</table>

### Chat window menus

The Chat Window menus contain options for most of the functions you need to manage a chat session.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Use the File menu options to end your participation in the chat session or print the text of a chat session.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>From the Edit menu, you can copy and paste text from a chat session to the Windows clipboard or from the Windows clipboard to the chat window.</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>The Options menu lets you control how you are alerted when new text appears in the Chat Window.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Use the View menu to control the appearance of the Chat Window.</td>
</tr>
</tbody>
</table>
Menu Options

**Actions** Use the options on the Actions menu or the corresponding menu shortcuts to perform the same operations as those available on the Chat Window toolbar.

**Help** The Help menu displays the online help.

**Configure the Chat window**

Use the Chat window View menu to control the appearance of the Chat window (Figure 25).

From the View menu, add or clear checkmarks to control whether the Chat window Toolbar, Status Bar or Side Bar are visible.

To configure the Chat window:

- To display the Toolbar, from the Chat window View menu, select **Toolbar**.
- To display the Status Bar, from the Chat window View menu, select **Status Bar**.
- To display the Side Bar, from the Chat window View menu, select **Side Bar**.

![Figure 25. Configure the Chat window.](image)
Configure chat alerts

Use the Chat window Options menu to control how you are alerted when someone types additional text in a chat session. For example, you can minimize an ongoing chat session to work on something else, yet be alerted by a sound or the reopening of the Chat window when one of the other participants types something.

To configure chat alerts:

- To restore a minimized chat window when there is new activity, from the Chat Window Options menu, select Pop on new text.
- To play a sound when there is new activity, from the Chat window Options menu, select Play sound on new text.

Initiate a Chat session

If you have the appropriate rights, you can initiate and participate in intercom chats with other Interaction Client .NET Edition users.

Intercom chats, or chat sessions between Interaction Client .NET Edition users, can include two or more users. To initiate intercom chats between two or more other users, you must create a chat conference.

Note: Before you can initiate a chat, the IC administrator must grant you "Allow Intercom Chat" user rights in Interaction Administrator. Intercom chats can take place only between users on the same IC server. You cannot initiate a chat session with a user on a peer server.

To initiate a chat session with another Interaction Client .NET Edition user:

1. In the Company Directory, highlight the name of the person with whom you wish to chat.
2. Do one of the following:
   - Click the Initiate new Chat icon in the Company Directory toolbar.
   - Right-click the person and choose Initiate new Chat from the menu that appears. The Chat window opens.

Note: If the chat recipient does not answer, you are prompted to leave a message. Press Disconnect after typing the message.
Pickup a chat request

When someone sends a chat request to you, Interaction Client .NET Edition sends a message to your email account and the chat request appears in your My Interactions queue. To join the chat session, click the Pickup button. The Chat window appears.

To pickup a chat session request:

Do one of the following:

- In My Interactions highlight the chat request and click the Pickup button.
  
  **Note:** A chat request in My Interactions is indicated by the icon.

- In the desktop alert (toast popup), click Pickup.

  **Note:** A chat request also appears as an alerting interaction in a desktop popup (toast). Desktop pop-ups appear in the lower right-hand corner of your Windows desktop Interaction Client .NET Edition.

Edit a chat Session

Use the Edit menu (Figure 26) in the Chat window to copy all or part of a chat session to the Windows clipboard and from there to a text-based Windows application. For example, you could copy the chat session text to Word or Notepad by clicking Select All and then clicking Copy.

![Figure 26. Chat window Edit menu.](image)

You can also copy text from files open in Windows applications to the chat session. If you have a standard reply to a frequently-asked question stored in a document, you could use Windows Copy and Paste operations to copy the response from this document to the dialog part of a chat session. Then click Send, just as if you’d typed the response.
Place a chat session on Hold

You can place a chat on hold to free yourself up for other interactions. When you place a chat session on hold, Interaction Client .NET Edition may send you another phone call, email, or chat session. While a chat session is on hold, you are free to make a call or initiate another chat session.

To place a chat session on hold, in the Chat Window, simply click the Hold button. In the My Interactions page, the chat’s state changes to "On Hold." To return to the chat session, click the Pickup button.

The Hold and Pickup actions are also available from the Actions menu in the Chat Window.

The Hold button is depressed while the chat session is on hold. Also, "Held" appears in the Status bar at the bottom of the Chat window.

Transfer a chat session

You can transfer a chat session to another user or to a workgroup. Use this option if you want an agent assigned to the type of request a chat recipient makes, or if you want a more experienced agent to handle the chat request.

To transfer a chat session:

1. To open the Transfer window, do one of the following:
   - In the Chat window, click the Transfer button.
   - In the Chat window, from the Actions menu click Transfer.
   - In the Chat window, press Ctrl+T.
   - In My Interactions, select the chat session. Right-click on a name in a directory and select Transfer.

   Note: You can transfer a chat session by clicking and dragging it to a selected recipient in the Company Directory or to a workgroup in the Workgroup and Profile Page.

2. In the Transfer To box, type the extension to which you want to transfer the chat.

3. Click Transfer Now. When you transfer a chat session to another user, Interaction Client includes the existing chat conversation with the transfer, which enables the transfer recipient to review the transcript when they join the chat.
Send a chat session request to voicemail

Rather than answer an incoming (alerting) chat session request, you can send that request to your voice mail. You can also send a chat participant with whom you are connected into your voice mail.

To send an alerting or connected chat to voice mail:

1. Select the chat session, if it is not already selected.
2. Click the Voice Mail button. The chat session requester or participant is sent to your voice mail. When the requester or participant has finished leaving a message, you are notified by email that you have a new voice mail message.

Record a chat session

You can record a chat session between other Interaction Client users (intercom chat) or between you and remote chat participants (web chat). This feature may or may not be available to you, depending on the rights assigned to you in Interaction Administrator.

Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or state law restrictions regarding Record or Listen capabilities of IC software. The licensee hereby warrants and represents that the end-user or licensee will use the product in compliance with any federal or state law.

To record a chat session:

- In the Chat window, click the Record button the first time to start the recording session for a chat.
- Click the Record button again to stop the recording session for a chat.
- You can press the Record button more than once to stop or continue recording your call.
- The Record button appears shaded if the chat is not in a state in which this action can be performed, or if you do not have rights to record interactions.

The Record feature saves only the text entered in a chat session while you have the Record button pressed. After the chat session ends, Interaction Client stores all parts of the recorded chat, and sends it to you in an email attachment (Figure 27).
Pausing a chat session recording

When you record a chat session, you can use the **Pause** button to temporarily stop the recording session. To pause a chat session recording:

- While recording a chat, click the **Pause** button to temporarily stop the recording.
- When a recording is paused, click the **Pause** button again to resume the recording session.
- The **Pause** button appears shaded if the call is not in a state in which this action can be performed.

Mark a chat session as private

You can mark a chat session as private. You may want to use this option to prevent other Interaction Client users from recording or listening to your conversation.

**Warning**: Use of the Private feature may be subject to your company's policies and should only be used in accordance with those policies. IC handler customization can be used to track the use of the Private feature to ensure compliance with such policies.
To mark a chat session as private, click the **Private** button. This button appears shaded if the call is not in a state in which this action can be performed.

**Add notes to a chat session**

Use the Notes tab in the Chat window to add notes or comments about the interaction that other Interaction Client users can view. Notes that other internal users add are appended to the chat text. You can make notes or comments about a chat on the Notes tab of the Chat window. Internal Interaction Client .NET Edition users can view these notes.

**To add notes to a chat:**

1. In the **Chat** window, click the **Add Note** button. The **Add a Note** window opens (Figure 28).

![Figure 28. Add a Note window.](image)

2. In the **Please enter a note** box, type your observations or comments and click **OK**. Your notes appear in the **Notes** tab in the **Chat** window.

**Assign codes to a chat**

You can assign an Account Code or Wrap-Up Code to a chat session. The Account Code and Wrap-up Codes dropdown lists appear in your Chat Window if they are defined in Interaction Administrator for your workgroup.

- You can assign an **Account Code** or **Wrap-Up Code** during a chat session by selecting the appropriate code in the **Chat** window (Figure 29).

![Figure 29. Assign a code during a chat session.](image)
• If wrap-up codes are available and you do not assign one during a chat, you are prompted when you close the chat session to assign the appropriate **Wrap-Up Code** (Figure 30).

**Figure 30. Assign a code after a chat session.**

### Conference two or more chat sessions

You can create conference chats by bringing members from two or more separate chat sessions into a single chat session. Before you begin, you should have two or more connected chat session objects in your My Interactions queue.

**To conference two or more chat sessions:**

1. Initiate a chat session.
2. Initiate a second chat session with a different Interaction Client .NET Edition user.
3. In your **My Interactions** queue, click and drag one of the connected chat sessions onto the other chat session. In your **My Interactions** queue, the two chats are placed under a single **Chat Conference** call object that is identified by "Conference" in the **Name** column.
4. Repeat steps 2 and 3 for any additional participants you want to add to the chat conference.

**Note:** The name of each chat participant appears in the **Chat Members** list in the **Chat** window.

5. When the session is complete, click the **Disconnect** button in the **Chat** window, or on the **Interactions** page of Interaction Client .NET Edition to end the chat conference.
Print a chat session
You can print the text of a chat session from the Chat window from the Chat Window File menu (Figure 31).

![Chat window File menu]

Figure 31. Chat window File menu.

To print the text of a chat session:

- Select **Page Setup** to adjust page size, orientation, and margins before printing the chat session.
- Select **Print Preview** to preview a chat session printout.
- Select **Print** to print the text of a chat session.

Disconnect a chat session
There are several ways to disconnect or end a Chat Session. To disconnect a chat session, do one of the following:

- Close the **Chat** window by clicking the Windows control in the upper right corner.
- In the **Chat** window, click the **Disconnect** button.
- In the **Chat** window or with the chat session selected in **My Interactions**, press **Ctrl+D**.
- In **My Interactions**, select the chat interaction and click the **Disconnect** button.
Request assistance from your supervisor

Within Interaction Client .NET Edition, you can request assistance by sending a message to your contact center supervisor(s). For example, if a caller asks you a question that you cannot answer or if you are in the middle of a web chat and need additional assistance, click on the Assistance button.

When you click the Assistance button on the Call Control toolbar, or in the Chat or Email toolbars, the Request Assistance window opens. In this window, type a brief description of your problem, click Send, and your request will be routed to all configured supervisors running Interaction Supervisor.

Note: The Assistance button may or may not be available, depending on the security rights assigned to you in Interaction Administrator. In addition, the Assistance button is enabled only for ACD (Automatic Call Distribution) calls or ACD-routed chats. This button appears shaded if the interaction is not in a state in which this action can be performed.

Workgroup Supervisors

Workgroup supervisors are configured in Interaction Administrator. Supervisors receive assistance requests only if they are running Interaction Supervisor. They do not receive assistance requests if they are running only Interaction Client Win32 Edition, Interaction Client .NET Edition, or Interaction Client Outlook Edition.

Note: For a supervisor to receive your request for assistance, at least one supervisor must be configured for your workgroup in Interaction Administrator on the Roles/Supervisor tab. This enables you and other members of your workgroup to request assistance on ACD-routed calls.

Requesting Help

1. In My Interactions, highlight the call or web chat for which you need help. On the Call Control toolbar, click Assistance or right-click the call and choose Request Assistance from the menu that appears. Or In the Chat window, click Assistance.

2. The Request Assistance window opens (Figure 32). In the Problem Description box, type a brief explanation of why you need assistance.
Request assistance from your supervisor

3. To route the request to your supervisor, click Send. Or to cancel the request, click Cancel.

4. You can monitor the status of your request in the Responses box of the Request Assistance window (Figure 33).

When you send the request, the workgroup supervisor receives an assistance request in Interaction Supervisor. Also, all supervisors on the same IC server see a popup toast assistance request.
Responding to a Callback request

Using the Callback feature, visitors to the Web site can leave a request for an agent to call them back. A visitor starts the Callback process by clicking the appropriate button on the Web page and completing information in the Callback window (Figure 34).

From the web page, the visitor enters a name and telephone number, types the subject of the request, and clicks the Send button. The system sends the request to you in your Interaction Client .NET Edition’s My Interactions queue.

Note: You can assign an account code and/or a wrap-up code per call, as well as add notes related to the callback.

In addition, if you prefer not to see the sidebar view, click the splitter (circled in red in Figure 34), to collapse that portion of the Callback window.

Respond to a Callback request

1. Double-click the Callback interaction, or highlight it and click the Pickup button. The Callback window opens.

2. Click the Make Call button to return the call.
Wrap up the Callback session for reporting purposes

After you complete a Callback session, for reporting purposes you must indicate the disposition of the session. Click either of the following buttons, depending on the result of your Callback session:

- **Call Succeeded** indicates the call was completed. Interaction Client .NET Edition disconnects the **Callback** object.

- **Call Failed** indicates the Callback session was not completed (due to, for example, a busy signal, no answer, party not available, and so on) and re-activates the **Make call** button so you can make another Callback attempt.
Determine if Someone is Listening to or Recording Your Interactions

Two columns can appear in your My Interactions list: **Lstns** and **Recs**. If someone is listening to or recording your interaction, an icon is shown in the appropriate column. This feature is available on all interactions (calls and chats).

- If someone is listening to your call, the **Listen** icon is displayed.
- If someone is recording your call, the **Record** icon is displayed.

For example, a supervisor may decide to listen to or record an interaction in your ACD workgroup. In addition, multiple supervisors can listen or record an interaction. If more than one user listens to or records your interaction, the number of listeners or recorders appears next to the appropriate icon.

**Note:** Any user can record any interaction on any queue that the user has permission to modify, except for interactions marked Private.

**Icon Display Examples**

In the following illustration, the **Record** icon in the first column of **My Interactions** indicates that you are recording the interaction. This line represents the recording you are making (a recording object). The **Record** icon in the **Recs** column on the line for the interaction indicates that someone is recording the interaction. In this case, it is you.

In the next illustration, the **Record** icon in the **Recs** column for the interaction along with the absence of a recording object with a **Record** icon in the first column indicates that someone else is recording the interaction.
Determine if Someone is Listening to or Recording Your Interactions

If a number appears next to the **Record** icon, it indicates the number of people who are recording the interaction.

A **Record** icon appears at the bottom of the **Chat** window if you initiate a recording during a chat session.

### Recs and Lstns Columns

Several settings control the behavior of recording and listening in Interaction Client .NET Edition. **Recs** and **Lstns** columns do not appear in **My Interactions** or other queue pages by default. Before you can display these columns, the IC administrator must grant you appropriate user rights (Allow Monitor Columns) in Interaction Administrator. After the rights have been granted, you must add the **Lstns** and **Recs** columns to the appropriate pages, such as **My Interactions**.

**Note:** Depending on settings established by your IC administrator in Interaction Administrator, supervisors who listen to or record your call may not appear in these columns.

**Warning:** Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or state law restrictions regarding Record or Listen capabilities of IC software. The licensee hereby warrants and represents that the end-user or licensee will use the product in compliance with any federal or state law.
Setting General Options

1. From the Options menu, click Configuration, and click the General node.

2. In the General page, complete the fields as described below in General Options Settings.

3. Click OK to close the Configuration dialog box.

General options settings

- **Show actual status icon in system tray:** Select this checkbox to replace the Interaction Client .NET Edition icon with an icon associated with your status (Available, Away from Desk, etc.).

- You may want to show the actual status icon to see your current status at a glance. You may, however, wish to turn this option off if you prefer to see the same Interaction Client .NET Edition icon or if you have trouble remembering the application to which the status icons belong.

- **Confirm drag and drop operations:** Select this checkbox to confirm drag and drop operations such as dragging and dropping calls on another call to create a conference call.

- **Confirm Single Click Dialing:** Select this checkbox to display a confirmation dialog box anytime you initiate a call by single-clicking on a number in your Call History or Company directory. This gives you the opportunity to click Yes or No before the call is dialed.
Enabling a Plugin

Plugins are components that can be dynamically added to Interaction Client .NET Edition to provide extended functionality. Plugins are first made available on the IC server by an administrator, then they become visible to you as an available option in Interaction Client .NET Edition.

See the Plugins node in the Configuration dialog box for a list of plugins available in your installation.

Note: In Interaction Administrator, the IC administrator controls which plugins are visible to the end user in User Configuration - Access Control. The IC administrator can also designate a plugin as required. Required plugins are included in Interaction Client .NET Edition interface by default and do not appear on the Plugins Page. Required plugins include Call History and Auto Status Changer.

In general, the process of enabling a plugin includes these steps:

1. The IC administrator makes the plugin available on the IC server.
2. In Interaction Administrator, the IC administrator controls which plugins are visible to the end user in User Configuration - Access Control.
3. You select the checkbox associated with the plugin on the Plugins page of the Configuration dialog box, then enable it by selecting Apply or OK.

Availability of plugins

Plugins are first made available on the IC server by an administrator. Access Control rights in Interaction Administrator then determine whether a plugin appears as an available option in Interaction Client .NET Edition. The list of available plugins appears in the Plugins page of the Configuration dialog box. Contact your IC administrator if you have a question about the availability of a specific plugin.

Note: Required plugins are included in Interaction Client .NET Edition interface by default and do not appear on the Plugins Page. Required plugins include Call History and Auto Status Changer.
Enabling a Plugin

**Note:** When you enable a plugin, some necessary files are downloaded from the IC server to Interaction Client .NET Edition. Subsequently, plugin availability is determined by comparing information on the IC server with corresponding information in Interaction Client .NET Edition. Therefore, if you run disconnected, or the server connection fails, or you change to another IC server, previously enabled plugins may not be available or only the plugins that were loaded when you last closed Interaction Client .NET Edition may be available.

4. Some plugins require configuration. If this is the case, the newly enabled plugin appears as a node on the left side of the Configuration dialog box. Select the appropriate node and complete the necessary configuration settings.

![Figure 35. Plugins on the Configuration Page.](image-url)
Plugins Page
Use the Plugins page to enable the plugins you want to use in your Interaction Client .NET Edition.

To enable a plugin:
1. To access the plugin options, from the Options menu, click Configuration, and click the Plugins node.
2. Available plugins are listed in the Plugins page. Select the checkbox for the plugin you want to enable.
   Note: A description of the currently selected plugin appears at the bottom of the Plugins page.
3. Click Apply to save your selections.
4. Click OK to close the Configuration dialog box.

Configuring a Plugin
Some plugins must be both enabled and configured before using them.

- In order for contact screen pops to occur, after enabling the Contact Pop - Outlook plugin, see Configure Contact Screen Pop in the Interaction Client .NET Edition Online Help.
- To display the Call Control toolbar in selected Microsoft applications, after enabling the Office Call Control Toolbar plugin, see Call Toolbar for Microsoft Office in the Interaction Client .NET Edition Online Help.
- To use Interaction Client Outlook Edition to dial Microsoft Outlook contacts, see Outlook Dialing Plugin in the Interaction Client .NET Edition Online Help.

For more information about plugins, see your IC administrator.
Launching Site-Specific Applications for Incoming ACD Interactions

Enhanced screen pop capability directs Interaction Client .NET Edition to automatically launch, or pop, specific applications when agents and other users receive interactions within their ACD queue.

For example, let’s assume you want Internet Explorer to automatically launch your company’s web page on your workstation when you receive an interaction in your ACD queue. If your administrator has configured the proper settings, including assigning the website popup to various states of the interaction, such as ‘alerting’ in Interaction Administrator, then your company website will open when the defined interaction enters your queue. This feature can be used to allow customers the ability to launch various support features such as CRM tickets, your company’s knowledgebase, order forms, quotation requests, and more, when an ACD call arrives.

You cannot perform typical actions, such as picking up, placing on hold, transferring, and so on, for these kinds of interactions.

Screen pop functions are defined in Interaction Administrator (Actions container). This feature may or may not be available to you, depending on the rights assigned to you by your system administrator. If you have any questions about using enhanced screen pop capability, see your administrator.
Understanding Advanced User Keyboard Shortcuts

Interaction Client .NET Edition contains short-cuts to increase proficiency with frequently performed functions. The shortcuts work only if the call, page, or queue is selected before you perform the action by clicking the mouse or navigating with the Tab and arrow keys.

**Note:** Shortcut keys apply to the active window. Some Interaction shortcut key combinations are identical to some Directory shortcut key combinations, so it is very important to be aware of which window has focus before you use the shortcut keys.

The focus indicator arrow (.setCursor) will help show you which window has the focus.

**Interaction shortcuts**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+N</td>
<td>Request Supervisory Assistance</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Call Back</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Coach</td>
</tr>
<tr>
<td>Ctrl+Shift+C</td>
<td>Create Conference</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy to Clipboard</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Disconnect</td>
</tr>
<tr>
<td>Ctrl+H</td>
<td>Hold</td>
</tr>
<tr>
<td>Ctrl+J</td>
<td>Join</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Listen</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Mute Call</td>
</tr>
<tr>
<td>Ctrl+K</td>
<td>Park</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Pause/Resume Recording</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Pickup</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Private</td>
</tr>
<tr>
<td>Ctrl+Shift+P</td>
<td>Properties</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Record</td>
</tr>
<tr>
<td>Ctrl+Shift+R</td>
<td>Remove</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Transfer</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Voicemail</td>
</tr>
</tbody>
</table>
### Directory shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+A</td>
<td>Camp</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Dial Assistant</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Dial Business Phone (1)</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Dial Business Phone (2)</td>
</tr>
<tr>
<td>Enter</td>
<td>Dial Default Number</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Dial Fax Number</td>
</tr>
<tr>
<td>Ctrl+H</td>
<td>Dial Home Phone (1)</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Dial Home Phone (2)</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Dial Mobile Phone</td>
</tr>
<tr>
<td>Ctrl+G</td>
<td>Dial Pager</td>
</tr>
<tr>
<td>Ctrl+Shift+X</td>
<td>Dial Extension</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Send Email (Business)</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Send Email (Home)</td>
</tr>
<tr>
<td>Ctrl+Shift+P</td>
<td>Properties</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Change User’s Status</td>
</tr>
<tr>
<td>Ctrl+Shift+C</td>
<td>Initiate New Chat</td>
</tr>
</tbody>
</table>

### Menu shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+F+O</td>
<td>Logout</td>
</tr>
<tr>
<td>Alt+F+S</td>
<td>Change Station</td>
</tr>
<tr>
<td>Alt+F+U</td>
<td>Check for Updates</td>
</tr>
<tr>
<td>Alt+F+C</td>
<td>Close (hide)</td>
</tr>
<tr>
<td>Alt+F+X</td>
<td>Exit</td>
</tr>
<tr>
<td>Alt+V+D</td>
<td>Dial Pad</td>
</tr>
<tr>
<td>Alt+V+A</td>
<td>Active Camps</td>
</tr>
<tr>
<td>Alt+O+R</td>
<td>Rules</td>
</tr>
<tr>
<td>Alt+O+C</td>
<td>Configuration</td>
</tr>
<tr>
<td>Alt+O+A</td>
<td>Audio tuning wizard</td>
</tr>
<tr>
<td>Alt+O+V</td>
<td>Change station volume</td>
</tr>
</tbody>
</table>
Additional keyboard tips

With the Interaction Client .NET Edition, you can use the Tab keys, arrow keys, and others to navigate the system:

- Press **Win+C** to pop Interaction Client .NET Edition, regardless of the application currently running in the foreground. If an interaction is in your queue, the focus is on **My Interactions**. If a call is not selected, the focus goes to the **Number** field, allowing you to quickly make a call.

- Press **F2** to give focus to **My Interactions** and press **F3** to give focus to the **Company Directory**. These shortcuts are assigned.

- When a tab in a docked area has focus (as indicated by the focus indicator arrow), you can move between tabs within that zone with your left and right arrow keys. If you want to move to a different docked area, use **Alt+[left, right, up, or down]** arrow key.

- A list of recently called names and numbers is available from the **Number** drop-down list. Eliminate unwanted numbers from this list by selecting an entry and pressing **Delete**.

- Use the keyboard to perform a call transfer from start to finish. For example, let’s assume you want to pick up an incoming call, place it on hold, and transfer it to a Company Directory recipient:

  A call pops Interaction Client .NET and the focus is on My Interactions.

  1. Use the arrow keys to highlight the call, press **Ctrl+P** to pick it up, and press **Ctrl+H** to place it on hold.

  2. Press **F3** to move the focus to the **Company Directory**, type the name of the transfer recipient, use the arrow keys to select the recipient, and then press **Enter** to transfer the call.

The focus returns to My Interactions. You may now select another call in your queue.

- A list of names and numbers you have recently called is available from the **Number** drop-down list. You can eliminate unwanted numbers from this list by choosing an entry and pressing the **Delete** key.
Working with Interaction Tracker Filtered Directories

Interaction Client .NET Edition users can create a new Interaction Tracker Filtered Directory based on Interaction Tracker contacts. These directories can be created using filter specifications based on existing contact information in the Interaction Tracker database. Interaction Tracker Filtered Directories allow you to communicate quickly and easily with contacts in directories created from your established Interaction Tracker Filtered Directories customer accounts.

Before you can create, add, or use Interaction Tracker Filtered Directories, you must first enable the Tracker plugin and then create the directories in Interaction Client .NET Edition.

**Note:** Interaction Tracker Filtered Directories will only be available if your administrator gives you access.

For more information on this feature, or if you have questions about your rights to use it, see your administrator or the *Interaction Tracker Filtered Directories* online help.

---

Enable the Interaction Tracker Directory Plugin

Before you can create an Interaction Tracker Filtered Directory, you must first enable the Tracker plugin. The Tracker Filtered Directories plug-in is installed during IC 2.4 Client Feature Pack installation. For more information on plugins, see *Enabling a Plugin* on page 105.

**Note:** Interaction Tracker Directories are available only to users who have been granted a Tracker Access license. See your IC administrator if you have questions about the license or your access to the Tracker plugin.

1. To access the plugin options, open the **Options** menu, click **Configuration...**, and click the **Plugins** node.
2. Select the **Tracker** checkbox.
3. Click **Apply** to save your selection. The **Interaction Tracker Directories** node is added to the **Client Pages** window.
Create a new Interaction Tracker Filtered Directory

You can create and add a new Interaction Tracker Filtered Directory from the Client Pages window (Figure 36).

To create the Interaction Tracker Filtered Directory:

1. Open the Options menu and choose Pages.... Or right-click anywhere in the Interaction Client .NET Edition pages area and choose Pages... from the menu that appears. The Client Pages window opens.

2. From the Categories list, select Interaction Tracker Directories and then click the New button. The Interaction Tracker Directory Settings window opens (Figure 37).

Note: None of the filter criteria fields in the Interaction Tracker Directory Settings window are required. You can filter for any of the filter fields, or none. If you only specify a name, and no filter criteria, the directory will be created but will not contain any contacts.
3. In the **General**, **Address**, and **Attributes** boxes, specify the filtering criteria for the new Tracker directory. The contacts created for this directory will be based on the information in the existing Interaction Center Tracker database. Select the following information that you want to be considered when creating your new directory. For more information on filtering criteria, see *Interaction Tracker Filtered Directories* in the Technical Reference Documents section of the IC Documentation Library on the IC Server.

4. To save your Interaction Tracker Directory settings, click **OK**. The new directory appears in the **Pages** area of the **Client Pages** window. When you select the box, the directory tabbed page appears in your Client.
Add an Interaction Tracker Filtered Directory to your client window

1. Open the Options menu and choose Pages.... Or right-click anywhere in the Interaction Client .NET Edition pages area and choose Pages... from the menu that appears. The Client Pages window opens.

2. From the Categories list, select Interaction Tracker Directories (Figure 36).

3. In the Pages area, place a checkmark in the box next to the Interaction Tracker directory you wish to add.

4. Click OK. The system displays the selected Interaction Tracker directories in your client window.

Edit an Interaction Tracker Filtered Directory

You can edit an existing Interaction Tracker Directory to update the filtered information and contacts included in the directory.

To edit an existing Interaction Tracker Directory:

1. Open the Options menu and choose Pages.... Or right-click anywhere in the Interaction Client .NET Edition pages area and choose Pages... from the menu that appears. The Client Pages window opens.

2. From the Categories list, select Interaction Tracker Directories.

3. In the Pages area, click the Interaction Tracker directory you want to update and then click the Edit button. The Interaction Tracker Directory Settings window opens (Figure 37).

4. Edit the desired information for which to filter and display directory contacts, then to save your changes click OK.
Working with Interaction Tracker Filtered Directories

**Note:** When you edit an activate Interaction Tracker directory currently displayed in your Interaction Client .NET Edition window, after you complete and save the updates the system deactivates the directory and removes it from the client window.

You must add the directory back to your window. See *Add an Interaction Tracker Filtered Directory to your client window* on page 115.

**Deactivate an Interaction Tracker Filtered Directory**

You can remove an Interaction Tracker Client directory page from your client window, but this does not delete the directory from the **Client Pages** window. You may choose to deactivate a directory if you don’t currently want to display it in your client window, but would like to have it available for use in the future.

To remove the directory from the client window, right-click the Interaction Tracker Directory tab and choose **Remove Directory** from the menu that appears. The directory page no longer appears in your Interaction Client .NET Edition window, but still exists as an option in the **Client Pages** window.

**Delete an Interaction Tracker Filtered Directory**

1. Open the **Options** menu and choose **Pages...**. Or right-click anywhere in the Interaction Client .NET Edition pages area and choose **Pages...** from the menu that appears. The **Client Pages** window opens.

2. From the Categories list, select Interaction Tracker Directories.

3. In the **Pages** area, click the Interaction Tracker directory you want to remove and then click the **Delete** button.

4. The **Delete Page** window opens, asking you to confirm your decision to permanently remove the directory. Click **Yes** to continue, or click **No** to cancel.

5. Click **OK** to close the **Client Pages** window and return to Interaction Client .NET Edition window.
Working with Additional Configuration Options

Customize columns
Right-click a column label in a queue or directory to display a menu with entries for each available column that can be added or removed.

Add or remove a column from a page
1. Right-click on the column headings for the page. A drop-down list of available column names appears.
2. To add a column, click the name of a column.
3. To remove a column, click the name of a column with a checkmark.

Reorder columns
1. Click on a column heading.
2. Drag it over the desired location.
3. Release the column heading.

Advanced – Workgroup Activation
If you have been given a certain administrative right to “Activate Self” in other workgroup queues, you can select the Workgroup Activation menu under Options. This displays the Manage Activation dialog that lets you add yourself to other workgroup queues that may need additional help answering calls.

If you do not have the right to see this option, the call center supervisor may have the right to add you and other agents to different workgroup queues that need help.

Figure 38. The optional Manage Activation dialog.
Need Help?

You can get help by opening the Help menu and choosing Help Contents from the menu that appears. The table of contents that appears lists all of the things that you can do with Interaction Client .NET Edition. Index and Search tabs are also available.

Feedback and Access Support
Options on Interaction Client .NET Edition’s Help menu provide the ability to learn more about Interactive Intelligence’s products, promote and share ideas about Interactive Intelligence’s software, access technical support, and submit feedback about bugs and enhancement requests.

Note: You must have internet access to visit the Interactive Intelligence website or submit feedback.

1. To visit the Interactive Intelligence home page, open the Help menu, select Interactive Intelligence, and then click Home.

2. To visit the Interactive Intelligence Interactive Community, do one of the following. Interactive Community is a free and public service provided by Interactive Intelligence to promote an online community devoted to the sharing of ideas and information regarding Interactive Intelligence software.

   - From the Help menu, choose Interactive Intelligence, and then click Community.
   - From the Help menu, choose About, then in the About Interaction Client dialog box, click the Community button.

3. To access the Interactive Intelligence technical support website, do one of the following:

   - From the Help menu, choose Interactive Intelligence, and then click Support.
   - From the Help menu, choose About, and then in the About Interaction Client dialog box, click the Feedback button.
4. To submit **product feedback** and report bugs, request enhancement, or submit other product-related information to Interactive Intelligence, do one of the following:

   • From the **Help** menu, choose **Interactive Intelligence**, and then click **Feedback**.
   
   • From the **Help** menu, choose **About**, then in the **About Interaction Client** dialog box, click the **Feedback** button.

5. To submit **documentation feedback**, send email to documentation@inin.com.